Copyright and Trademark Information

© 2012 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, Ansoft, AUTODYN, EKM, Engineering Knowledge Manager, CFX, FLUENT, HFSS and any and all ANSYS, Inc. brand, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries in the United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of their respective owners.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement.

ANSYS, Inc. is certified to ISO 9001:2008.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. If you are unable to access the Legal Notice, please contact ANSYS, Inc.

Published in the U.S.A.
# Table of Contents

1. Introduction: What is AQWA? ................................................................. 1

2. Approach ......................................................................................... 3

   2.1. Import or Create Hydrodynamic Analysis Systems ........................................... 3
   2.1.1. Import a Hydrodynamic System Database .................................................. 3
   2.1.2. Create a Hydrodynamic Analysis System ............................................... 3

   2.2. Attach Geometry ........................................................................ 4
   2.2.1. General Modelling Requirements ........................................................ 5
   2.2.2. Configuring the Geometry ................................................................. 6
   2.2.3. Add Fixed Points .............................................................. 7

   2.3. Define Parts Behavior ............................................................... 7
   2.3.1. Surface Body .................................................................... 10
   2.3.2. Line Body ........................................................................ 11
   2.3.3. Point Mass ....................................................................... 12
   2.3.4. Point Buoyancy ............................................................... 12
   2.3.5. Disc ............................................................................... 12
   2.3.6. Additional Hydrodynamic Stiffness ................................................... 13
   2.3.7. Additional Damping (Frequency Independent) ................................... 14
   2.3.8. Additional Added Mass (Frequency Independent) .................................. 14
   2.3.9. Current Force Coefficients ....................................................... 14
   2.3.10. Wind Force Coefficients ......................................................... 17
   2.3.11. Structure Connection Points ..................................................... 19

   2.4. Define Connections ................................................................ 19
   2.4.1. Cables ........................................................................... 19
   2.4.1.1. Linear Elastic .......................................................... 21
   2.4.1.2. Non-Linear Polynomial .............................................. 21
   2.4.1.3. Non-Linear Steel Wire ............................................ 21
   2.4.1.4. Non-Linear Catenary ............................................ 22
   2.4.2. Catenary Data ............................................................... 23
   2.4.2.1. Catenary Section ................................................... 24
   2.4.2.2. Catenary Joint ......................................................... 25
   2.4.3. Connection Stiffness ......................................................... 25
   2.4.4. Fenders ...................................................................... 26
   2.4.4.1. Examples of Use of Fenders ........................................... 28

   2.4.5. Joints .......................................................................... 30
   2.4.5.1. Initial Positioning of Jointed Structures ........................................... 33
   2.4.5.2. Moving Structures .................................................... 34
   2.4.5.3. Closed Loops ............................................................ 34
   2.4.5.4. Removing a Joint ......................................................... 36

   2.5. Mesh ................................................................................. 37
   2.5.1. Mesh Sizing ................................................................. 37

   2.6. Establish Analysis Settings ...................................................... 38
   2.6.1. Time Response Options ....................................................... 38
   2.6.2. Output File Options .......................................................... 39
   2.6.3. QTF Options ................................................................ 41
   2.6.4. Common Analysis Options ................................................... 41

   2.7. Applying Ocean Environment and Forces ............................................. 44
   2.7.1. Structure Selection .......................................................... 44
   2.7.2. Gravity ........................................................................ 45
   2.7.3. Wave Directions .............................................................. 45
   2.7.4. Wave Frequencies .......................................................... 45
2.7.5. Structure Force .................................................. ................................................... ..................................... 46
2.7.6. Regular Wave .......................................................... ................................................... .................................. 47
2.7.7. Irregular Wave ................................................ ................................................... .................................. 48
  2.7.7.1. Jonswap (Hs or Alpha) ................................................ ................................................... 49
  2.7.7.2. Pierson-Moskowitz .......................................................... ................................................... 50
  2.7.7.3. Gaussian .......................................................... ................................................... 50
  2.7.7.4. User Spectra (1D) .......................................................... ................................................... 50
  2.7.7.5. User Time History ................................................ ................................................... 51
2.7.8. Irregular Wave Group .......................................................... ................................................... ..................................... 52
2.7.9. Current .......................................................... ................................................... 54
2.7.10. Wind .......................................................... ................................................... 55
  2.7.10.1. Ochi and Shin Spectrum .......................................................... ................................................... 57
  2.7.10.2. API Standard Spectrum .......................................................... ................................................... 58
  2.7.10.3. NPD Standard Spectrum .......................................................... ................................................... 59
  2.7.10.4. ISO Standard Spectrum .......................................................... ................................................... 60
  2.7.10.5. User Defined Spectrum .......................................................... ................................................... 60
  2.7.10.6. Time Dependent Velocity .......................................................... ................................................... 63
2.7.11. Cable Winch .......................................................... ................................................... 64
  2.7.11.1. Winch that Maintains Constant Tension .......................................................... ................................................... 65
  2.7.11.2. Winch that Changes Cable Length .......................................................... ................................................... 65
2.7.12. Cable Failure .......................................................... ................................................... 66
2.8. Solution .......................................................... ................................................... 67
2.8.1. Hydrostatic Results .......................................................... ................................................... 68
2.8.2. Hydrodynamic Graphical Results .......................................................... ................................................... 69
  2.8.2.1. Hydrodynamic Diffraction Results .......................................................... ................................................... 72
    2.8.2.1.1. Diffraction, Froude-Krylov, Diffraction + Froude-Krylov, Linearized Tube Drag, and Total Exciting Force Including Tube Drag .......................................................... ................................................... 72
    2.8.2.1.2. Response Amplitude Operators (RAOs) and RAOs with Linearized Tube Drag .......................................................... ................................................... 73
    2.8.2.1.3. Radiation Damping & Added Mass .......................................................... ................................................... 74
    2.8.2.1.4. Steady Drift .......................................................... ................................................... 75
    2.8.2.1.5. Sum QTF and Difference QTF .......................................................... ................................................... 75
    2.8.2.1.6. Splitting Forces .......................................................... ................................................... 76
    2.8.2.1.7. Bending Moment and Shear Force .......................................................... ................................................... 77
  2.8.2.2. Hydrodynamic Time Response Results .......................................................... ................................................... 79
    2.8.2.2.1. Structure Position .......................................................... ................................................... 79
    2.8.2.2.2. Structure Velocity .......................................................... ................................................... 80
    2.8.2.2.3. Structure Acceleration .......................................................... ................................................... 80
    2.8.2.2.4. Structure Forces .......................................................... ................................................... 81
    2.8.2.2.5. Fender Forces .......................................................... ................................................... 83
    2.8.2.2.6. Joint Forces .......................................................... ................................................... 83
    2.8.2.2.7. Cable Forces .......................................................... ................................................... 83
    2.8.2.2.8. Time Step Error .......................................................... ................................................... 84
  2.8.3. Hydrodynamic Pressures and Motions Results .......................................................... ................................................... 84
  2.8.4. Time History Motion Results .......................................................... ................................................... 87
3. Workbench Interface .......................................................... ................................................... 89
  3.1. Hydrodynamic Systems in the Project Schematic .......................................................... ................................................... 89
  3.2. The AQWA Editor User Interface .......................................................... ................................................... 90
  3.3. Setting AQWA Application Options .......................................................... ................................................... 93
4. Common Features .......................................................... ................................................... 95
  4.1. Generating Reports .......................................................... ................................................... 95
  4.2. Parameters .......................................................... ................................................... 95
  4.3. Comments, Images, and Figures .......................................................... ................................................... 96

Release 14.5 - © SAS IP Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
4.3.1. Comments ................................................................. ................................................... ......................... 96
4.3.2. Images ......................................................................................................................... 97
4.3.3. Figures ......................................................................................................................... 97

5. Systems ................................................................................................................................. 99
  5.1. Hydrodynamic Diffraction System ................................................................. ................................................... 99
  5.2. Hydrodynamic Time Response System ................................................................. ................................................... 99

6. Appendix ............................................................................................................................... 101
  6.1. Information for existing AQWA users ................................................................. ................................................... 101
  6.2. Transferring Pressures and Motions (Frequency Domain) to Mechanical Models .......... 103

Index ........................................................................................................................................ 105
Chapter 1: AQWA Introduction: What is AQWA?

ANSYS AQWA provides an engineering toolset for the investigation of the effects of wave, wind and current on floating and fixed offshore and marine structures, including: spars; floating production, storage, and offloading (FPSO) systems; semi-submersibles; tension leg platforms (TLPs); ships; renewable energy systems; and breakwater design.

AQWA Hydrodynamic Diffraction provides an integrated environment for developing the primary hydrodynamic parameters required for undertaking complex motions and response analyses. Three-dimensional linear radiation and diffraction analysis may be undertaken with multiple bodies, taking full account of hydrodynamic interaction effects that occur between bodies. While primarily designed for floating structures, fixed bodies such as breakwaters or gravity-based structures may be included in the models. Computation of the second-order wave forces via the full quadratic transfer function matrices permits use over a wide range of water depths.

AQWA Hydrodynamic Diffraction can also generate pressure and inertial loading for use in a structural analysis as part of the vessel hull design process. The results from a diffraction analysis can be mapped onto an ANSYS Mechanical finite element model for further structural assessment and detailed design. Since the mapping function automatically accounts for mesh differences between the hydrodynamic and finite element models they do not have to be topologically identical.

AQWA Hydrodynamic Time Response provides dynamic analysis capabilities for undertaking global performance assessment of floating structures in the time domain. A wide range of physical connections, such as mooring lines, fenders, and articulations, are provided to model the restraining conditions on the vessels. In addition, sea-keeping simulation may be undertaken with the inclusion of forward speed effects. Slow-drift effects and extreme-wave conditions may be investigated, and damage conditions, such as line breakage, may be included to study any transient effects that may occur.
Chapter 2: AQWA Approach

This chapter takes you through the different steps required to setup a hydrodynamic analysis.

2.1. Import or Create Hydrodynamic Analysis Systems

2.1.1. Import a Hydrodynamic System Database

To import an existing hydrodynamic system database, do the following:

1. In Workbench, click on the Import button (or select File>Import).
2. In the Import window, select Files of type: AQWA Database (*.aqdb).
3. Click on a .aqdb database, and select Open to open the AQWA Editor and create an AQWA Hydrodynamic Diffraction system for each Analysis contained within the database.

The above technique may be used to duplicate complex connected systems that you cannot otherwise replicate using the Duplicate function. Once saved in Workbench as a Workbench project, you may use Workbench File>Open to open an existing Workbench Project containing hydrodynamic systems.

2.1.2. Create a Hydrodynamic Analysis System

Each analysis type is represented by an analysis system that includes the individual components of the analysis such as the associated geometry and model properties. Most analyses are represented by one independent analysis system. However, an analysis with data transfer can exist where results of one analysis are used as the basis for another analysis. In this case, an analysis system is defined for each analysis type, where components of each system can share data.

- To create an analysis system, expand the Analysis Systems section in the Toolbox and drag an analysis object template onto the Project Schematic. The analysis system is displayed as a vertical array of cells (schematic) where each cell represents a component of the analysis system. Address each cell by right-clicking on the cell and choosing an editing option.
To create an analysis system with data transfer to be added to an existing system, drag the object template representing the upstream analysis directly onto the existing system such that red boxes enclose cells that will share data between the systems. After you release the mouse button, the two systems are displayed, including an interconnecting link and a numerical designation as to which cells share data.

See Working Through an Analysis System for more information.

Note

In hydrodynamic analysis systems, the Geometry cell is the only cell that can share data with other types of analysis systems.

2.2. Attach Geometry

There are no geometry creation tools in the AQWA application so geometry must be attached to the hydrodynamic system. You can create the geometry from either of the following sources:

- From within Workbench using DesignModeler. See the DesignModeler Help for details on the use of the various creation tools available.
- From a CAD system supported by Workbench. See the CAD Integration section for a complete list of the supported systems.

Before attaching the geometry from either of these sources, you can specify several options that determine the characteristics of the geometry you choose to import by right clicking on the Geometry cell and choosing Properties. See the CAD Integration section for more details about the options, most of which do not apply in hydrodynamic analyses. Also see the General Modelling Requirements section for more information about the implications of Geometry import properties.

Note

AQWA only processes the Line Bodies and Surface Bodies in a geometry. Make sure that the boxes are checked for both of these Geometry options in the Properties view. You can attach a geometry that has no line or surface bodies, but AQWA will not process the geometry.

Related Procedures

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Condition</th>
<th>Procedural Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifying geometry options</td>
<td>Optional task that can be done before attaching geometry.</td>
<td>1. In an analysis system schematic, perform either of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Right-click on the Geometry cell and choose Properties</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Select the Geometry cell in the schematic for a standard analysis, the from the Workspace toolbar drop down menu, choose any option that includes Properties or Components.</td>
</tr>
<tr>
<td>Procedure</td>
<td>Condition</td>
<td>Procedural Steps</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Attaching DesignModeler geometry to a hydrodynamic system</td>
<td>DesignModeler is running in an analysis system.</td>
<td>1. Double-click on the <strong>Model</strong> cell in the same analysis system schematic. The AQWA application opens and displays the geometry.</td>
</tr>
</tbody>
</table>
|                                   | DesignModeler is not running. Geometry is stored in an agdb file. | 1. Select the **Geometry** cell in an analysis system schematic.  
2. Browse to the agdb file from the following access points:  
   - Right-click on the **Geometry** cell in the **Project Schematic**, **Import Geometry** and choose **Browse**.  
3. Double-click on the **Model** cell in the schematic. The AQWA application opens and displays the geometry.  
4. If required, set geometry options in the AQWA application by highlighting the **Geometry** object and choosing settings under **Preferences** in the Details view. |
| Attaching CAD geometry to a hydrodynamic system | CAD system is running. | 1. Select the **Geometry** cell in an analysis system schematic.  
2. Right-click on the **Geometry** cell listed there.  
3. Double-click on the **Model** cell in the same analysis system schematic. The AQWA application opens and displays the geometry.  
4. If required, set geometry options in the AQWA application by highlighting the **Geometry** object and choosing settings under **Preferences** in the Details view. |
|                                   | CAD system is not running. Geometry is stored in a native CAD system file, or in a CAD “neutral” file such as Parasolid or IGES. | 1. Select the **Geometry** cell in an analysis system schematic.  
2. Browse to the CAD file from the following access points:  
   - Right-click on the **Geometry** cell in the **Project Schematic** and choose **Import Geometry**.  
3. Double-click on the **Model** cell in the **Project Schematic**. The AQWA application opens and displays the geometry. |

**CAD Interface Terminology**

The CAD interfaces can be run in either plug-in mode or in reader mode.

- **Attaching geometry in plug-in mode**: requires that the CAD system be running.
- **Attaching geometry in reader mode**: does not require that the CAD system be running.

**2.2.1. General Modelling Requirements**

DesignModeler is the ANSYS tool used to create geometry for hydrodynamic systems. For information on importing geometry created in DesignModeler, see the **Geometry** section. When using DesignModeler
to define the geometry there are a number of aspects that you should consider to ensure that your
model is suitable for analysis with AQWA, such as:

- Ensure that the model is split at the water line. Import or create each structure and then use a plane
to split the surface bodies at the water level.

- When using lines to create beams, only tubular sections are supported in AQWA; all other sections
will result in a stub element being formed and you will need to define additional information in the
AQWA application. Lines should be created using Add Frozen Operation on the Line Details, and
consist of only 1 Point Segment per line.

- Each vessel / structure should be a part, so all the bodies that you have should be grouped via the
multibody part facility. Note, it is not possible to rename these within the AQWA application.

- The model is oriented with its Z axis vertical up.

- Surfaces must have normals pointing outward.

Hydrodynamic analysis systems only process the Line Bodies and Surface Bodies in a geometry. By default,
Line Bodies are not imported with the geometry. To change this default setting, in the Workbench
window, select Tools > Options and click on the Geometry Import entry in the tree. Make sure that
the boxes are checked for Solid Bodies, Surface Bodies and Line Bodies as needed. You can attach a
geometry that has no line or surface bodies, but this is not appropriate for an AQWA analysis.

You can also set the Geometry import options on a per system basis. When a system is initially created,
the default geometry import settings will be used. If you would like to change the import settings for
a particular system, right click on the Geometry cell in that system and select Properties. Use the check
boxes in the Properties view to set the items to import for this system. These settings are sent to the
editor to use on edit or import. If you change the settings after initially editing the model you will need
to refresh the cell, or edit and refresh, to consume the change and reattach the geometry with the new
CAD import settings.

2.2.2. Configuring the Geometry

On opening a hydrodynamics analysis system the AQWA Editor will automatically attach the geometry.
Each part becomes a separate structure in AQWA. If a structure is to be formed of both diffracting and
non-diffracting elements, these should be in separate defined bodies within the (multi-body) part.

When attaching a geometry, the units also change to be those of the model; these can be modified via
the units menu if desired.

The hydrodynamics systems assume the still water surface is parallel to the XY plane, and Z is positive
up.

All structures are located in a global analysis space; note that Hydrostatic Results and Hydrodynamic
Graphical Results are also presented in global directions.

Within the geometry you can select the types of bodies that will be attached.

Once attached the diffracting behavior of surface geometry can be selected; lines can be set to be Tu-
bular (TUBE Elements) or Slender Tube (STUB elements) and additional AQWA specific objects can be
added, such as Point Mass, Point Buoyancy and Disc.

The Details panel provides you with options for setting up the sea geometry’s Water Level, Water
Depth, and size (Water Size X, Water Size Y), which can be used to alter the graphical view. The sea
level must coincide with the point where the surface geometry is split to form above water (non-diffracting) and below water (diffracting) sections. By default, this setting in the Surface Body Details view will be Program Controlled and determined from the water level; however, you can manually override it to define specific bodies to be non-diffracting.

It is important that the correct water depth is specified, especially with shallow water conditions, since the sea bed acts as a boundary condition to the diffraction analysis. The Water Size in the X and Y directions modifies the extent of the graphical display of the water surface and sea bed.

The Water Density can also be changed.

---

**Note**

*It is not yet possible to employ symmetry in the AQWA Editor, hence the full model must be meshed.*

---

### 2.2.3. Add Fixed Points

A Fixed Point is a non-moving point defined as part of your geometry. Fixed connection points are defined in the Details panel by entering coordinates in global space or specifying an offset from a vertex on a structure. The coordinates defining the connection point can be parameterized. A fixed point does not move with any structure (even if it is initially defined as offset from a point on a structure). A fixed point can be used by more than one object (cable, fender, etc.), if required. The option to choose a fixed point vs. connection points on structures is controlled by the Connectivity field in the Details panel of the object using the connection points.

To add a fixed point, click on the Geometry object in the tree, and from the Add menu in the toolbar or the right click menu, select **Fixed Point**. Click on the Fixed Point object that was added and do one of the following:

- **Set Definition of Position** to Coordinates, and set the Position Coordinates (*X Ordinate*, *Y Ordinate*, *Z Ordinate*) in the Details panel.

- **Set Definition of Position** to Vertex Selection. Click on Select a Single Vertex in the Vertex field, select a vertex on a structure, and click **Apply**. You can then set an *X Offset*, *Y Offset*, or *Z Offset* from the vertex if needed.

---

**Note**

It is assumed that fixed points are on the sea bed for catenary cables.

Prior to Release 14.5, these objects were labeled as “Connection Point”.

---

### 2.3. Define Parts Behavior

A part is a group of geometric entities that form a ship or other structure that is to be analyzed in AQWA. The name is read in from the geometry database and the graphical view will show the part; the appropriate structure will be highlighted when the part in the tree is selected. Each part will be assigned a structure number for the analysis. The parts can be included or excluded from the analysis using the Structure Selection.

A number of options can be set for each part in the Details panel.
To help visualization, it is possible to show or hide specific parts using the **Part Visibility** option. The **Part Activity** option is used to decide what structures are used in the analysis.

**Note**

If a part is suppressed, it cannot be used in the analysis. However, when a part is unsuppressed, it must be added to the **Structure Selection** in order for it to be included in the analysis.

**Total Structural Mass**, and **X, Y, and Z Positions of COG** (the Center of Gravity) are displayed for each Part. This information is based on the masses defined for each element/body of the structure: Point Masses and Tubes/Stubs. It is important to remember that the mass of each Point Mass is defined either manually by the user, or automatically by the program after the hydrostatic calculation has been done and is up-to-date. If the hydrodynamic diffraction system is not up to date, this information is solely based on the initial 1kg mass attributed to each point mass, if its definition is Program Controlled, or on any subsequent out-of-date hydrostatic analysis.

If an internal lid is required to prevent irregular frequency problems then **Generate Internal Lid** can be set to Yes and it will be automatically generated during the AQWA analysis. Note that an automatically generated lid will not be displayed. Alternatively, a manually generated lid may be used; create an appropriate plane surface as a **Surface Body**; set **Structure Type** to Abstract Geometry and **Abstract Type** to Internal Lid. If you have a structure with a moon pool where large resonant waves may occur, then you can form an external lid using a predefined geometry Surface Body with **Structure Type** set to Abstract Geometry and **Abstract Type** to External Lid.

The **Current Calculation Depth** defines the depth below the water surface at which the current velocity is to be computed for use in the calculation of the hull drag loading. By default the current at the water surface is used. Note that hull drag loads are only included if **Current Force Coefficients** are defined for the part.

By default the structure is set to be free to move. Alternatively, the whole structure can be fixed by setting **Structure Fixity** to Structure is Fixed in Place. Fixity primarily affects the results of a hydrodynamic diffraction analysis by impacting the structure's RAOs. It therefore also has an impact on the hydrodynamic time response results as the calculated drift forces depend on these RAOs. It is thus necessary to impose the coherence between the setup of the two analyses by fixing the structure in the time response analysis. Since the user can create joints to be used in time response analysis, it is the user's responsibility to create a rigid joint when it is connected to a fixed point on any Part marked as Fixed in the Details dialog. Not doing so will result in an error when solving the time response analysis.

The **Mass Factor** and **Drag Factor** provide a way of modifying the added mass and drag coefficients defined for any tube and disc elements associated with this part. This may be used for parametric studies where the effects of Morison drag on appropriate elements are considered important (e.g. simulating tests at model scale). These factors have no effect on any other object type in the part.

The **Slam Factor** provides a way to enable the computation of slamming loads on tube and disc elements. By default a factor of zero is specified which disables this computation. Any positive non-zero value will cause the program to compute the slam coefficient for each applicable element, based on the premise that the slam force is equal to the rate of change of the added mass tensor (with time) multiplied by the velocity. The resulting coefficient is then multiplied by this factor. This may be used for parametric studies where the effects of slamming loads on tube and disc elements are considered important (e.g. simulating tests at model scale). This factor has no effect on any other object type in the part.
Slamming loads can also be included for stub elements by setting the Slam Factor to a positive non-zero value, but the magnitude of the factor is immaterial in this case because a value of unity is always employed in the analysis.

**Note**

The method for computing the slam coefficient requires that the time-step used in time history analysis must be sufficiently small to accurately represent the added mass at each stage of immersion/emergence. In general, this will depend on the geometry of each element and its orientation to the water surface. In practice, this severe restriction of the size of the time-step means that this facility is only used when specifically investigating the effects of slam forces on individual elements during critical stages of the simulation period, as the momentum change due to slam forces are normally small and have little effect on the overall motion of the structure.

**Submerged Structure Detection** is Program Controlled by default, and AQWA will detect the highest point (greatest Z coordinate) and check whether it is below the water level; alternatively, this automatic detection can be overridden.

The Metacentric Heights can be overridden about both the global X (Override Calculated GMX = Yes) or Y (Override Calculated GMY = Yes) axes to modify the hydrostatic stiffness of the vessel. When these are overridden, AQWA first calculates the hydrostatic stiffness matrix based only on the cut water plane and displaced volume properties. It then adjusts the second moments of area IXX, IYY and calculates its associated properties, PHI (principal axis), GMX/GMY, BMX/BMY etc. to give the required GM values. The associated additional hydrostatic stiffness is calculated automatically and stored in the hydrodynamic database. If the GM value input is less than that based on the geometry alone, the resulting additional stiffness will be negative. This would be the case if ballast tanks were being modelled, making the structure less stable, statically.

Nonlinear roll damping moment can be calculated in slow drift time history analyses to take into account the effect of vortex shedding from the bilges of a vessel. The method is based on "An Engineering Assessment of the Role of Non-linearities in Transportation Barge Roll Response", Robinson and Stoddart, Trans. R.I.N.A 1986.

Whether vortex shedding is occurring or not is calculated by the program based on the relative flow velocity at the bilge, Keulegan-Carpenter number, roll natural frequency of the vessel, and the radius of the bilge. The roll damping coefficient used in the nonlinear roll damping force calculation is also calculated by the program based on a database stored within the program.

To compute the effects of nonlinear roll damping, select Included in Calculations from the **Non-Linear Roll Damping** drop-down menu. By default, these are excluded from the calculations. If selected, additional parameters need to be provided. It is assumed that the two bilges have symmetric properties about the center line of the vessel. The Bilge Radius defines the local radius of the bilge corner (dimension from the hull to the extreme of the bilge). The Depth to Bilge is the vertical position of the bilge corner on the vessel in the global axis system. The Offset of Bilge from Central Line is the lateral offset of the bilge corner from the center line of the vessel in the global axis system. The central line is defined by selecting vertices from the geometry for the start and end points of the central line (Reference...
**Vertex for Start of Central Line, Reference Vertex for End of Central Line**. For each end of the central line, you can also specify X and Y offsets.

**Note**

The vertical position of the vertices selected for the central line end points is irrelevant; the vertical position of the central line is set by **Depth to Bilge**.

**Additional Hydrodynamic Stiffness, Damping** and **Added Mass** can be added to the Part object using the context menu, or from the Add menu on the toolbar when the Part is selected.

Use the context (right click) menu or the toolbars to add additional AQWA specific elements into the geometry, such as: **Point Mass, Point Buoyancy, Disc, Wind Force Coefficients,** and **Current Force Coefficients**. You can remove any of the objects by right clicking on them in the tree and selecting **Delete** from the context menu.

---

A full list of the types of bodies is:

2.3.1. **Surface Body**
2.3.2. **Line Body**
2.3.3. **Point Mass**
2.3.4. **Point Buoyancy**
2.3.5. **Disc**
2.3.6. **Additional Hydrodynamic Stiffness**
2.3.7. **Additional Damping** (Frequency Independent)
2.3.8. **Additional Added Mass** (Frequency Independent)
2.3.9. **Current Force Coefficients**
2.3.10. **Wind Force Coefficients**
2.3.11. **Structure Connection Points**

**2.3.1. Surface Body**

Surface bodies are areas that can be **meshed** to create diffracting or non-diffracting elements for the AQWA analysis. The name of the surface body will be obtained from that given in Design Modeler and it cannot be changed here.

If a body is not required for the analysis it can be suppressed (**Body Activity**). Suppressed bodies will not be meshed and will be excluded from the analysis. You can hide the body in the graphic window (**Body Visibility**), in which case it will not be shown but will be included in the analysis.
It is possible to change the type of surface from a Physical Geometry to an Abstract Geometry (Structure Type). For physical geometry, Program Controlled Surface Type will set all surface bodies below the water surface as diffracting and those above will be non-diffracting. If required, those below the water surface can be manually defined as non-diffracting elements for the analysis. This may be required, for instance, when part of the structure is in contact with the sea bed, or where contact occurs underwater between adjacent parts.

For an abstract geometry, Abstract Type provides a number of options to select how this geometry is to be used. If an area is of particular interest, then the Custom Results Positions option enables a mesh to be applied and each node of the mesh will form a field point element; additional information will be available at these points. Alternatively, Internal Lid and External Lid can be used to suppress standing waves either between structures or within structures.

**Note**

Automatic internal lids can be selected using the Part option.

If the generation of an external lid is specified, two additional parameters are required. The first is a Lid Damping Factor, set between 0 and 1. The factor represents how effective the lid is to be; 0 will result in no effect, while 1 will prevent any vertical water surface velocity under the lid.

The second parameter is the Gap for Lid. It is a representative size for the lid; typically the distance between the two vessels or the width of a moon-pool. It enables the lid properties to be tuned to the resonant frequency of waves in the gap.

### 2.3.2. Line Body

Line bodies are used to create single elements for AQWA. How they are interpreted depends upon the cross section of the line; if it has a circular cross section, then it will be automatically converted into a tubular line and will create standard tubular (TUBE) elements. All other sections will create slender tube (STUB) elements. The content of the details pane changes considerably depending upon the type of line. The details are discussed below.

**Line type: Tubular**

If the line in Design Modeler was defined with a tubular section, the line body will default to this setting; the tube Diameter and Thickness are automatically read from the Design Modeler data, along with the calculated inertia values.

Use Tube Type to make the tube Sealed or Floodable. By default, the tube is sealed, and in this case the tube would be buoyant; however, the tube does not have longitudinal drag or added mass unless discs are created at the ends. Discs can automatically be applied at either (Created at End A Only, Created at End B Only) or both (Created at Both Ends) ends with the Tube End Discs option; if you choose one of these options, default disc parameters are used. If you require different parameters, discs can be excluded here and added manually.

A Viscous Drag Coefficient and Added Mass Coefficient can be defined, although drag is not used in Hydrodynamic Diffraction or hydrostatic analyses. A density of the tube (Material Density) is also required; this defaults to the standard value for steel.
**Line type: Stub**

For all sections other than tubular, only the inertias will be obtained automatically from the parameters that are entered in Design Modeler. If a stub element is not required, then it is possible to change it to a tubular line and define the diameter and thickness within the AQWA Editor.

There are options to change the diameter of a stub element in both the local Z and Y directions (**Z Diameter**, **Y Diameter**), as well as the **Cross Section Area**. For AQWA, valid cross sectional areas vary between an ellipse and a rectangle with the width and height of the two diameters. In addition, you can specify a Viscous Drag Coefficient and Added Mass Coefficient in each of the Z and Y directions. It is also possible to define the mass contribution of the stub to the model (**Mass/Unit Length**). You cannot automatically add Discs to STUB objects, but you can add them manually if needed.

### 2.3.3. Point Mass

Point mass elements can be inserted into the model; the properties can either be input manually or can be Program Controlled.

If **Mass definition** is set to Manual, the point mass must have all its properties input by the user (**Mass**, **X**, **Y**, and **Z** coordinates). If a Program Controlled point mass is used, the mass and the horizontal position will be calculated from the panel elements in the structure (i.e. excluding tubular stub lines and point buoyancy bodies). The mass will equal the mass of water displaced, and the horizontal position will be that of the center of buoyancy.

The moments of inertia (or radii of gyration) and vertical position (**Z**) cannot be determined by the program and must always be input. Moments of inertia can be defined directly or by inputting radii of gyration. If **Define inertia values by** is set to via Radius of Gyration, you need to enter **Kxx**, **Kyy**, and **Kzz**. If you select Direct input of Inertia, you must enter the **Ixx**, **Iyy**, and **Izz** values.

**Tip**

After inserting your point masses, solve for hydrostatics only; then the hydrostatic results will be available and the values of mass will be calculated before performing the full AQWA analysis.

### 2.3.4. Point Buoyancy

Point buoyancy (PBOY) elements can be inserted into the model; these require a position (**X**, **Y**, **Z**) and a **Volume**.

### 2.3.5. Disc

Disc elements can be used to create an area that has drag (**Viscous Drag Coef**) and added mass (**Added Mass Coef**) in the direction perpendicular to the disc. The **Diameter** of the disc is required along with the centroid and the definition of the normal direction. If the centroid is at the position of an existing vertex, set **Centroid Definition** to Select Vertex and click Pick in the **Vertex** field; then select the vertex on the model and click **Apply**. To enter the coordinates of the vertex directly, set **Centroid Definition** to Specify Coordinates, and enter the **X**, **Y**, and **Z** values.

You can specify the normal by picking a second vertex or specifying the direction of a normal vector. To use an existing vertex to define the normal, set **Normal Definition** to Select Second Vertex and click on Pick in the **Normal Vertex** field; then select the vertex on the model and click **Apply**. To enter the
vector for the normal directly, set **Normal Definition** to Specify Vector Components, and enter the **Normal X**, **Normal Y**, and **Normal Z** component values.

The default values of the added mass and viscous drag coefficients can be modified if desired.

---

**Note**

*Drag is not used in hydrodynamic diffraction analyses.*

### 2.3.6. Additional Hydrodynamic Stiffness

This object may be used to input an additional linear hydrostatic stiffness matrix using tabular input in the Matrix Definition Data window. The linear stiffness matrix relates to the hydrostatic forces contributing to the equations of static equilibrium of a structure. Specifically, the net linear hydrostatic forces \( F(s) \), acting at the center of gravity of a structure, when the structure is at an arbitrary position \( X \), are given by:

\[
F(s) = (K + dK) (X(e) - X) + B(e)
\]

- \( K = \) stiffness matrix
- \( dK = \) additional hydrodynamic stiffness matrix input in this object
- \( X(e) = \) equilibrium position
- \( B(e) = \) buoyancy force at equilibrium

If additional hydrodynamic stiffness is used it should be checked that the above expression, which is used to calculate the linear hydrostatic forces throughout the AQWA suite, produces the forces on the structure intended by the user.

---

**Note**

*In this context, hydrostatic forces can act in all 6 degrees of freedom.*

In the equation above, the term \( X(e) \) is the diffraction analysis defined position. If the initial position in a subsequent motions analysis is not as defined in the diffraction run, then there will be restoring forces which will try to return the structure to the diffraction defined position.

To add an Additional Hydrodynamic Stiffness Matrix:

1. Select a part in the Tree Outline.
2. Right click on the part and select **Add > Additional Hydrodynamic Stiffness**.
   
   or

   Click on the **Add** icon in the toolbar and select **Additional Hydrodynamic Stiffness** from the dropdown list.

   An Additional Hydrodynamic Stiffness object is added to the part.
3. Select the Additional Hydrodynamic Stiffness object in the Tree Outline and enter the matrix coefficients in the Matrix Definition Data window that appears below the model.

### 2.3.7. Additional Damping (Frequency Independent)

This object may be used to input frequency independent additional damping in global directions using tabular input. Only one definition of Additional Damping per structure can be active (i.e. not suppressed) for the analysis and the values are added to those calculated automatically during the analysis.

To add Additional Damping:

1. Select a part in the Tree Outline.
2. Right click on the part and select **Add > Additional Damping**.
   
   or
   
   Click on the **Add** icon in the toolbar and select **Additional Damping** from the dropdown list.
   
   An Additional Damping object is added to the part.
3. Select the Additional Damping object in the Tree Outline and enter the matrix coefficients in the Matrix Definition Data window that appears below the model.

### 2.3.8. Additional Added Mass (Frequency Independent)

This object may be used to input frequency independent additional added mass in global directions using tabular input. Only one definition of Additional Added Mass per structure can be active (i.e. not suppressed) for the analysis and the values are added to those calculated automatically during the analysis.

To add Additional Added Mass:

1. Select a part in the Tree Outline.
2. Right click on the part and select **Add > Additional Added Mass**.
   
   or
   
   Click on the **Add** icon in the toolbar and select **Additional Added Mass** from the dropdown list.
   
   An Additional Added Mass object is added to the part.
3. Select the Additional Added Mass object in the Tree Outline and enter the matrix coefficients in the Matrix Definition Data window that appears below the model.

### 2.3.9. Current Force Coefficients

This object may be used to include the viscous drag of the current on the hull of a fixed or floating structure, using tabular input in the Current Force Coefficients window. The term current force coefficient is used to differentiate these coefficients from traditional drag coefficients and from coefficients of wind force.

The current force coefficients are defined as the force or moment per unit velocity squared. The moment is about the center of gravity of the structure. These forces are a function of the relative velocity between
the structure and the water. This means that the current coefficient should still be input even when there is no current present, as the relative velocity is generally non-zero for a dynamic analysis.

To add a Current Force Coefficients object:

1. Select a part in the Tree Outline.

2. Right click on the part and select **Add > Current Force Coefficients**.

   or

   Click on the **Add** icon in the toolbar and select **Current Force Coefficients** from the dropdown list.

   A Current Force Coefficients object is added to the part.

3. Select the Current Force Coefficients object in the Tree Outline and enter the coefficients in the Coefficient Data window that appears below the model. Enter the **Direction** of the current (-180 to +180 degrees), the X force coefficient (**Translation X**), Y force coefficient (**Translation Y**), Z force coefficient (**Translation Z**), Rotation about X coefficient (**Rotation X**), Rotation about Y coefficient (**Rotation Y**), and Rotation about Z coefficient (**Rotation Z**). The number of rows is increased as each entry is made, up to a maximum of 41 rows.

   Note that the forces are in the directions of the axes, not in the direction of the current. For example, for relative current velocity \( V \) in direction \( \varphi \):

   force in X direction = \( CUFX_{\varphi}V^2 \)

   force in Y direction = \( CUFY_{\varphi}V^2 \)

   moment about Z axis = \( CURZ_{\varphi}V^2 \)

   where \( CUFX, CUFY \) and \( CURZ \) are the coefficients. Similar equations apply for force in Z and moments about X and Y.

   The coefficients are applied in a moving axis system; in other words, the axes move with the structure. Since there is no structure local axis system available, the initial coefficient data must be defined relative to the global coordinate system when the structure is in the position as defined in the geometry. For example:
Note

- You may have multiple Current Force Coefficient objects in the analysis, but only one can be enabled during an analysis (an error will be reported when solving if multiple objects are enabled).

- There is a limit of 41 unique directions for the enabled Wind Force Coefficient and Current Force Coefficient tables combined. Each table may have an entry for the same Direction value.

- If a direction is specified for Wind Force Coefficients that does not exist for Current Force Coefficients then linearly interpolated values will be utilized for the Current Force Coefficients for that direction, based upon adjacent defined directions.
• An error will be reported if there are multiple entries having the same value of Direction in the table.

### 2.3.10. Wind Force Coefficients

This object may be used to include the viscous drag of the wind on the superstructure of a fixed or floating structure using tabular input in the Wind Force Coefficients window. The term wind force coefficient is used to differentiate these coefficients from traditional drag coefficients and from coefficients of current force.

The wind force coefficients are defined as the force or moment per unit velocity squared. The moment is about the center of gravity of the structure. These forces are a function of the relative velocity between the structure and the air. This means that the wind coefficient should still be input even when there is no wind present, as the relative velocity is generally non-zero for a dynamic analysis.

To add a Wind Force Coefficients object:

1. Select a part in the Tree Outline.
2. Right click on the part and select **Add > Wind Force Coefficients**.
   
   or

   Click on the **Add** icon in the toolbar and select **Wind Force Coefficients** from the dropdown list.

   A Wind Force Coefficients object is added to the part.

3. Select the Wind Force Coefficients object in the Tree Outline and enter the coefficients in the Wind Force Coefficients window that appears below the model. Enter the Direction of the wind (-180 to +180 degrees), the X force coefficient (**Translation X**), Y force coefficient (**Translation Y**), Z force coefficient (**Translation Z**), Rotation about X coefficient (**Rotation X**), Rotation about Y coefficient (**Rotation Y**), and Rotation about Z coefficient (**Rotation Z**). The number of rows is increased as each entry is made, up to a maximum of 41 rows.

   Note that the forces are in the directions of the axes, not in the direction of the wind. For example, for relative wind velocity \( V \) in direction \( \phi \):

   \[
   \text{force in X direction} = \text{WIFX}_{\phi} \cdot V^2 \\
   \text{force in Y direction} = \text{WIFY}_{\phi} \cdot V^2 \\
   \text{moment about Z axis} = \text{WIRZ}_{\phi} \cdot V^2
   \]

   where WIFX, WIFY and WIRZ are the coefficients. Similar equations apply for force in Z and moments about X and Y.

   The coefficients are applied in a moving axis system; in other words, the axes move with the structure. Since there is no structure local axis system available, the initial coefficient data must be defined relative to the global coordinate system when the structure is in the position as defined in the geometry. For example:
Note

- You may have multiple Wind Force Coefficient objects in the analysis, but only one can be enabled during an analysis (an error will be reported when solving if multiple objects are enabled).

- There is a limit of 41 unique directions for the enabled Wind Force Coefficient and Current Force Coefficient tables combined. Each table may have an entry for the same Direction value.

- If a direction is specified for Current Force Coefficients that does not exist for Wind Force Coefficients then linearly interpolated values will be utilized for the Wind Force Coefficients for that direction, based upon adjacent defined directions.
• An error will be reported if there are multiple entries having the same value of Direction in the table.

### 2.3.11. Structure Connection Points

A structure Connection Point is defined as a connection point attached to a Part, that moves with the Part. Connection points are defined in the Details panel by entering coordinates in global space or specifying an offset from a vertex on a structure. The coordinates defining the connection point can be parameterized. A structure connection point can be used by more than one object (cable, fender, etc.), if required. The option to choose a fixed point vs. connection points on structures is controlled by the Connectivity field in the Details panel of the object using the connection points.

To add a connection point on a structure, click on the Part object in the tree, and from the Add menu in the toolbar or the right click menu, select **Connection Point**. To set the initial position of the connection point, click on the Connection Point object that was added and do one of the following:

- Set **Definition of Position** to Coordinates, and set the Position Coordinates (X Ordinate, Y Ordinate, Z Ordinate) in the Details panel.

- Set **Definition of Position** to Vertex Selection. Click on Select a Single Vertex in the Vertex field, select a vertex on a structure, and click **Apply**. You can then set an X Offset, Y Offset, or Z Offset from the vertex if needed.

**Note**

Even if you define the initial position of the Connection Point using Coordinates, or with an offset from a vertex on the Part, the connection point is “attached” to the part and will move with the part, maintaining the relative position that you defined when you created it.

### 2.4. Define Connections

The Connections object allows you to create connections between structures or between structures and the environment. The available connections are:

- **2.4.1. Cables**
- **2.4.2. Catenary Data**
- **2.4.3. Connection Stiffness**
- **2.4.4. Fenders**
- **2.4.5. Joints**

#### 2.4.1. Cables

AQWA supports four types of cables, each with their own input requirements:

- **Linear Elastic**
- **Non-Linear Polynomial**
- **Non-Linear Steel Wire**
- **Non-Linear Catenary**
To add a Cable, click on the Connections object in the tree. From the Connections toolbar or the right click menu item **Insert Connection**, then select **Cable**.

The type of the cable (**Linear Cable**, **Polynomial Cable**, **Steel Wire Cable**, or **Catenary Cable**) can be set in the details panel.

Cables may either be joined between two structures, or a fixed point and a structure; this option can be changed via the **Connectivity** field in the Details panel. In both cases an **End Connection Point** must exist at the position of the end of the cable; this can be selected from a dropdown of existing Connection Points defined on the structures. When the starting point is on a structure, you can define the start of the cable using **Start Connection Point**, which again is a dropdown of existing connection points defined on the structures. When the starting point is a fixed point, a **Fixed Point** dropdown list of defined fixed points is shown.

Linear Elastic and Polynomial cables can be winched by adding a **Cable Winch**. All cable types can also have break conditions based on tension or time, defined by adding a **Cable Failure** object.

Set additional options in the Details panel for each cable type as described in the sections below. The extension of the cable and force applied depend on the Connectivity defined (the following information is not applicable to catenary cables):

**For a cable attached between a structure and a fixed point**

The extension of the cable, at any stage of the analysis, is calculated by subtracting the unstretched length from the distance between the position of the fixed point and the current position of the connection point on the structure.

The direction of this force is given by the vector going from the fixed point to the structure.

**For a cable attached between two structures**

The extension, at any stage of the analysis, is calculated by subtracting the unstretched length from the distance between the connection points on the two structures at the current position of the respective structures.

The direction of the force on a structure is given by the vector going between the two connection points. The forces on each structure will therefore always be equal and opposite and hence the selection of start and end connection points can be interchanged.

The unstretched length is used to indicate the length at which the mooring line is slack; i.e. if the distance between the two attachment points at either end of the mooring line is less than this value, then the tension in the mooring line will be zero. Although unusual, it is quite valid to input this value as zero where the ‘cable’ is never slack. However, in the special case where both ends of the cable are coincident, the direction of the force exerted by the cable is undefined and is automatically set to zero.

---

**Note**

If a cable is not defined properly before running the analysis, the cable will be drawn as a straight red line between the start and end, and an error will be reported in the Message window.
2.4.1.1. Linear Elastic

For linear elastic cables, a **Stiffness** and **Unstretched Length** need to be defined, and up to two pulleys can be defined along the line.

This is a very simple type of cable, simply a tension-only spring, where the tension is proportional to its extension, and the constant of proportionality is termed the stiffness. As the extension may vary during the analysis, the structure(s) to which the cable is attached will experience a force of varying magnitude and direction. The magnitude of this force, which is equal to the cable tension is given by:

\[ \text{Force} = \text{Stiffness} \times \text{Cable Extension} \]

Note that when the cable is slack, the cable extension is negative and the cable tension is set to zero.

**Pulleys**

A Pulley has the effect of intersecting the cable and will effectively extend the cable to pass via the pulley position. Adding a second pulley will extend the cable further from the first pulley to the end of the cable, hence the cable will travel from the cable start point to the first pulley then, if it exists, to the second pulley, and then to the cable end point.

Along with the pulley position (defined by **Connection Point** which can be selected from the dropdown list of existing connection points), you must enter a **Friction Coefficient** for the pulley. The friction of the pulley is represented by \( T_2/T_1 \), where \( T_2 \) is the larger tension and \( T_1 \) the smaller. \( T_2/T_1 \) is defined for the situation where the line turns through 180° around the pulley.

Within the program a friction factor \( \mu \) is calculated such that \( (T_2/T_1)=e^{\mu \pi} \). The friction is then varied depending on how far around the pulley the line passes.

\( T_2/T_1 \) must be in the range \( 1 \leq T_2/T_1 \leq 2 \), with 1 being no friction.

2.4.1.2. Non-Linear Polynomial

For Non-Linear Polynomial cables, enter the polynomial coefficients (**Coefficient A**, **Coefficient B**, **Coefficient C**, **Coefficient D**, **Coefficient E**) and **Unstretched Length** of the cable. The coefficients of the polynomial define the force in the cable as a function of extension, thus:

\[ \text{Force} = P_1.E + P_2.E^2 + P_3.E^3 + P_4.E^4 + P_5.E^5 \]

Where:

- \( P_1, P_2, P_3, P_4, P_5 \) = polynomial coefficients.
- \( E \) = Extension of the mooring line, as defined in the linear cable section.

2.4.1.3. Non-Linear Steel Wire

For Non-Linear Steel Wire cables, enter the **Asymptotic Stiffness** and **Asymptotic Offset** in addition to the **Unstretched Length** of the cable. These constants are physical properties used in defining the tension/extension curve of a steel wire mooring line.

Tension in a steel wire mooring line is given by:

\[ T = k \left( e - d \tanh(e/d) \right) \]
Where:

\( e = \) extension of mooring line

\( k = \) asymptotic stiffness (constant)

\( d = \) asymptotic offset (constant)

The names of the constants \( k \) and \( d \) arise from the fact that, at large values of extension, \( \tanh(e/d) \) tends to unity and the equation tends to the asymptotic form:

\[ T = k(e - d) \]

### 2.4.1.4. Non-Linear Catenary

Non-Linear Catenary Cables consist of up to 10 Catenary Sections and optionally 9 Catenary Joints between the sections. Catenary Sections and Joints can be defined under the Catenary Data object and accessed as required to build up a number of Non-Linear Catenary Cables. For each cable, the **Section Type** field allows you to select the Catenary Section via a drop down list; once chosen, the unstretched **Length** of that section can be entered. If more than one section is used then additional selections for the joint type are displayed to allow the selection of the Catenary Joint. The whole cable make-up is summarized in the Catenary Cable Definition Data table.

Each Non-Linear Catenary Cable can, optionally, be analyzed using cable dynamics to obtain the dynamic forces in the cable as well as their effect on the structures motion (Set **Use Dynamics to Program Controlled**). You can then enter the number of elements (**Number of Elements**) to use in the analysis of the cable. You must have **Use Cable Dynamics** set to Yes in the Hydrodynamic Time Response system's Analysis Settings in order to be able to use dynamics for an individual cable. If Use Dynamics is set to No for a cable whose Connectivity is Connection Point & Structure, the **Sea Bed Slope** parameter is made available. This value is the sea bed slope (in degrees) for this mooring line. A positive slope is for the sea bed to slope up from the anchor towards the attachment point, and a negative slope is for the sea bed to slope down from the anchor towards the attachment point. Note that the slope is ignored if cable dynamics is being used for the solution.

Once the cable is fully defined, the initial tensions at the start and end of the cable (**Initial Cable Tension @ Start**, **Initial Cable Tension @ End**) are reported in the Details panel.

To avoid the iterative calculation of the mooring forces, the program establishes a database covering all the expected configurations of the cable.

Additional controls enable fine control over the cable. The availability depends upon if the cable is attached between a fixed point and a structure, or between two structures.

For cables attached between a fixed point and a structure (**Connectivity** set to **Fixed Point & Structure**), the range of the possible end points of the cable is determined by **Negative dZ** (measured from the lowest anticipated database point to the connection point in the definition position) and **Positive dZ** (measured from the connection point in the definition position to the highest anticipated database point) along with the slack and maximum tension positions (including the effects of the **Sea Bed Slope**). This area is then divided up to form a database of cable end positions and corresponding tensions which is used in the analysis. It is recommended that the full size of this grid is used, of 600 points, which is formed by the multiplication of **Number of Vertical Partitions** and **Number of X Coordinates**.
For cables attached between two structures (Connectivity set to Structure & Structure), the range of the possible end points of the cable is determined by the relative positions of the two structures along with the slack and maximum tension range. It is assumed that the cable does not contact the sea bed. It is recommended that the full size of the database is used, of 600 points, which is formed by the multiplication of Number of Vertical Partitions and Number of X Coordinates.

For cables attached between two structures the database uses a radial coordinate system in which Number of X Coordinates becomes the number of radial distances and the Number of Vertical Partitions is the number of angular positions.

2.4.2. Catenary Data

Under the Connections object in the tree, a Catenary Data object is automatically added. Under this object, you can insert definitions for various types of Catenary Sections and Catenary Joints that can be used to create Catenary Cables.

2.4.2.1. Catenary Section
2.4.2.2. Catenary Joint

2.4.2.1. Catenary Section

To define the properties of a catenary section, right click on the Catenary Data item in the tree and select **Insert Catenary Data > Catenary Section**. Click on the Catenary Section object that you added and enter the following information in the Details panel:

- The mass per unit length (**Mass / Unit Length**) of the section of the composite mooring line.

- The **Equivalent Cross Sectional Area** of the mooring line. It is often more convenient, especially with wire lines, to specify this parameter so the buoyancy of the line may be calculated and subtracted from the structural weight to give the ‘weight in water’. This parameter may also be specified as zero if the mass per unit length is input as the mass of the line LESS the mass of the displaced water per unit length (this does not apply to the cases when cable dynamic analysis is required, for which a non-zero equivalent cross section area must be defined).

- The stiffness of the line (**Stiffness, EA**), specified in terms of EA, where E is Youngs modulus and A is the cross sectional area of the line. The default value is chosen to give a typical value based on the mass/unit length. Clearly this may be in error if the mass per unit length specified includes buoyancy effects.

- The **Maximum Tension**, which is the highest value of tension that should be used in the database created for this composite mooring line. It is important that this is a realistic value. If a very high value is input the database will cover a very large range of tensions, and the accuracy in the actual working range may be reduced. If a very small value is input the database will only cover a small range of tensions, and constant tension may occur for larger strain values, i.e. no extrapolation is carried out. If cable dynamics is utilized this limiting value is not applied.

- The **Axial Stiffness Coefficients (k1, k2, k3)**. A cable may have nonlinear axial stiffness. The stiffness is calculated using the formula:

  \[EA(\varepsilon) = EA(\text{const}) + k_1\varepsilon + k_2\varepsilon^2 + k_3\varepsilon^3 \text{ for } (0 \leq \varepsilon \leq \varepsilon_{t_{\text{max}}})\]

  or

  \[EA(\varepsilon) = EA(\varepsilon_{t_{\text{max}}}) + (k_1 + 2.k_2.\varepsilon_{t_{\text{max}}} + 3.k_3.\varepsilon_{t_{\text{max}}}^2)(\varepsilon - \varepsilon_{t_{\text{max}}}) \text{ for } (\varepsilon > \varepsilon_{t_{\text{max}}})\]

  where

  \[EA(\varepsilon) = EA \text{ as a function of strain}\]

  \[EA(\text{const}) = \text{the stiffness value input above}\]

  \[k_1, k_2, k_3 = \text{Nonlinear axial stiffness coefficients}\]

  \[\varepsilon = \text{linear strain } \delta L/L\]

  \[\varepsilon_{t_{\text{max}}} = \text{strain at } T_{\text{max}}\]

  \[T_{\text{max}} = \text{maximum tension specified above}\]

For Cable Dynamics analyses the following optional additional data may be input.
• The **Bending Stiffness** *(EI)*. The Bending Stiffness is specified in terms of EI, where *E* is Young’s modulus and *I* is the 2nd moment of area of the line. The default value is zero.

• The **Added Mass Coefficient** *(Ca)*. Added mass is calculated by \( \rho \times Ca \times A \) per unit length in which \( \rho \) is the water density and *A* is the equivalent cross section area. In other words, the added mass is equal to the displaced mass of water multiplied by *Ca*. For cable dynamic analysis, the equivalent cross section area *A* must **NOT** be omitted. The default is 1.0.

• The **Transverse Drag Coefficient** *(Cd)*. Transverse drag force is calculated by \( 0.5 \times \rho \times Cd \times V^2 \times De \) per unit length where *V* is the relative transverse velocity. The default is 1.0

• The **Equivalent Diameter** *(De)* for drag. This allows the drag to be based on a different diameter from the added mass. The default is \( \sqrt{\frac{4 \times A}{\pi}} \)

• The **Longitudinal Drag Coefficient** *(Cx)*. Inline drag force is calculated by \( 0.5 \times \rho \times Cx \times V^2 \times De \) per unit length where *V* is the relative inline velocity. The default is 0.025.

### 2.4.2.2. Catenary Joint

You can insert either a buoy or a clump weight between catenary cable sections (however, you do not need to specify a joint). Intermediate buoys always have the same buoyancy and do not “know” where the surface is. Therefore they may float above the water surface. To define the properties of a catenary joint, right click on the Catenary Data item in the tree and select **Insert Catenary Data > Catenary Buoy** or **Insert Catenary Data > Catenary Clump Weight**. Click on the Catenary Joint object that you added and enter the following information in the Details panel:

• **Section Joint Type** should be set to Buoy or Clump Weight based on your menu selection when adding the object.

• Specify the **Structural Mass** of the buoy or clump weight. This must be smaller than the mass of displaced water for a buoy, or larger for a clump weight. This can be positive, zero or negative.

• Specify the mass of water displaced (**Displaced Mass of Water**), i.e. the buoyancy/gravity. This can be positive, zero or negative.

• Specify the total (constant) **Added Mass**; i.e. not the added mass coefficient. Applicable to Cable Dynamics only.

• Specify the **Drag Coefficient * Area** (cable dynamics only); drag will be in the direction of the relative velocity of the fluid, *VR*. The magnitude of the force is given by \( FD = 0.5 \times \rho \times CDA \times VR \times |VR| \) where \( CDA = \text{Drag coefficient} \times \text{projected area} \).

### 2.4.3. Connection Stiffness

This object may be used to input a connection stiffness matrix between structures using tabular input in the Matrix Definition Data window.
The **Connectivity** can be set to Fixity & Structure for a structure connected to a point or Structure & Structure for two connected structures. Select the first and second (if present) structure in the **Connected Structure A** and **Connected Structure B** fields.

---

**Note**

A Connection Stiffness object only applies to a hydrodynamic diffraction analysis.

---

To add a Connection Stiffness Matrix:

1. Right click on the Connections object and select **Insert Connection > Connection Stiffness**.

or

Click on the Connections object and select **Connection Stiffness** from the Connections toolbar.

A Connection Stiffness object is added under Connections.

2. Select the Connection Stiffness object in the Tree Outline and enter the matrix coefficients in the Matrix Definition Data window that appears below the model.

3. Set the **Connectivity** and structure information as discussed above.

### 2.4.4. Fenders

Fenders are a type of mooring allowing the user to model material contact between two structures. They are the only way to model contact, so if there are no fenders, structures can pass through each other. From a practical point of view, like other mooring elements fenders are defined as acting between two structures or one structure and a fixed connection point.

Depending on the relative positions of the structure, on the type of Fender (floating, fixed unidirectional, fixed omnidirectional), and on their positions on the structures, they create a varying force acting on the structure and added to the other forces used for computing the structures' motions. These forces are calculated using the properties defined for each fender.

A Contact Plane is defined for each fender; this is the plane which the fender is going to impact. This plane is defined by a point and a vector.

An attachment point is defined for each fender. For fixed fenders, this is the point where the fender is located on the structure. For floating fenders, the attachment point is translated to the mean water surface.

Fixed unidirectional and floating fenders also have a direction of action, represented by a "normal vector". Along with the attachment point given in the fender’s definition, it defines a plane which is going to be the second plane pressing on the fender. For floating fenders, the actual attachment point is obtained by translating the original definition point down to the mean water surface, following this plane. It therefore models the ship's side, which is not necessarily vertical. Omnidirectional fixed fenders act in all directions.

The size of the fender must be specified. At each time step, the distance between the fender's attachment and the contact plane is calculated and compared to the fender's size. If the distance is shorter than the size, a force is calculated as a function of the difference following a polynomial law whose coefficients are part of the fender's definition. This force is applied to the structure at the fender's attachment point. The calculation of the distance depends on the type of fenders. Fixed unidirectional and floating fenders
have a direction along which the distance is calculated. For the omnidirectional fender, the distance is simply the shortest distance from the contact plane to the attachment point. Fenders can only have compressive forces.

To add a fender to your analysis, right-click on the Connections tree object and select Insert Connection > Fender, or click on the Connections object and select Fender from the Connections toolbar. You will need to enter the following information in the Details panel:

- **Connectivity** – Select the type of connectivity for the fender:
  - Fender and Contact on Structures
  - Fender On Structure, Contact On Fixed Point
  - Fender On Fixed Point, Contact On Structure

- **Type** – Fixed or Floating. Note that Floating fenders cannot have a horizontal connection plane. If there is more than a 60 degree angle between the Floating fender and contact plane directions, a warning is generated saying that the forces are in error. But this will not prevent the run from completing.

- **Action** – For a Fixed fender, you can select Omni-Directional, or for either fender type choose the axis (X Direction Only, Y Direction Only, or Z Direction Only) for a uni-directional fender.

- **Fender Connection Point, Contact Connection Point** – Allows you to select an existing Connection Point on a structure to define the fender attachment point and contact plane origin. These are present when the Fender/Contact is on a structure.

- **Fender Fixed Point, Contact Fixed Point** – Allows you to select from a dropdown list an existing Fixed Point for the Fender/Contact when the connectivity is specified as such.

- **Damping Coefficient** – Material (or structural) damping coefficient $\beta$. Damping is modelled as linear material damping, where the damping coefficient is $\beta x$ the stiffness. Damping is only applied in the direction perpendicular to the contact points.

- **Friction Coefficient** – This is the friction coefficient $\mu$. The friction force is given by $F = \mu R$, where $R$ is the normal reaction. The maximum value of $\mu$ is 0.5.

- **Size** – The fender size.

- **Polynomial Coefficient (A, B, C, D, E)** – The force acting on the structure is $Ax + Bx^2 + Cx^3 + Dx^4 + Ex^5$, where $x$ is the compression applied to the fender.

Fender friction works best in situations where the friction force is smaller than other forces in the same direction. Friction will slow down relative motion between two structures, but is not suitable for keeping them fixed together - there is no “sticktion”. When the relative velocity changes sign the friction force must also change sign, but to avoid an instantaneous change in force (and therefore an instantaneous change in acceleration) a smoothing function is applied. This means that when the relative velocity is very small the friction force is also small, and the structures can move relative to each other.

When inserting a fender, **Fender Axes** and **Contact Axes** objects are inserted as its children. These axes objects define the orientation of the fender and the contact plane. The orientation can be set using these fields in the Details panel for each axes object:

- **Alignment Method** – Select Global Axes to align the axes with the global axes. You can also set the alignment of the axes using the Vertex Selection or Direction Entry methods.
• **Origin Vertex, X Direction Vertex, Vertex Defining the XY Plane** – For an Alignment Method of Vertex Selection, select the **Origin Vertex** of the fender or contact plane, a vertex defining the X direction (X Direction Vertex), and a vertex that would, along with the other two vertices, define the XY Plane (Vertex Defining the XY Plane). As these vertices must be part of a body in the geometry, the user may have to anticipate and include, for instance, a dummy massless line body in the geometry oriented the same way as the fender to be defined. In DesignModeler you can, for example, create such a line body as being perpendicular to the surface of the hull.

• **Rotation about Global Z, Rotation about Local Y, Rotation about Local X** – For an Alignment Method of Direction Entry, define the alignment using these three rotation fields.

**Note**

The Fender Axis definition should point towards the contact surface i.e. through the fender itself. The Contact Axis definition should point towards the fender attachment surface i.e. opposite direction to the Fender Axis definition.

### 2.4.4.1. Examples of Use of Fenders

The following images show examples of using omni- and uni-directional fenders with various alignment methods.

**Omni-Directional Fender**

<table>
<thead>
<tr>
<th>Details</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details of Fender 1</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Fender 1</td>
</tr>
<tr>
<td>Visibility</td>
<td>Visible</td>
</tr>
<tr>
<td>Activity</td>
<td>Not Suppressed</td>
</tr>
<tr>
<td>Connectivity</td>
<td>Fender And Contact On Structures</td>
</tr>
<tr>
<td>Type</td>
<td>Fixed</td>
</tr>
<tr>
<td>Action</td>
<td>Omni-Directional</td>
</tr>
<tr>
<td>Fender Connection Point</td>
<td>Connection Point 1 (Part)</td>
</tr>
<tr>
<td>Contact Connection Point</td>
<td>Connection Point 2 (Part 2)</td>
</tr>
</tbody>
</table>
Uni-Directional Fender Aligned to X Axis

<table>
<thead>
<tr>
<th>Details of Fender 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td><strong>Visibility</strong></td>
</tr>
<tr>
<td><strong>Activity</strong></td>
</tr>
<tr>
<td><strong>Connectivity</strong></td>
</tr>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><strong>Action</strong></td>
</tr>
<tr>
<td><strong>Fender Connection Point</strong></td>
</tr>
<tr>
<td><strong>Contact Connection Point</strong></td>
</tr>
</tbody>
</table>
Uni-Directional Fender Aligned to Z Axis

2.4.5. Joints

A hydrodynamic analysis allows structures to be connected by articulated joints. These do not permit relative translation of the two structures but allow relative rotational movement in a number of ways that can be defined by the user.

To add a joint to your analysis, right-click on the Connections tree object and select Insert Connection > Joint, or click on the Connections object and select Joint from the Connections toolbar. To add a joint, you will need to enter the following information in the Details panel:

- **Type** – To add a joint, select the type of joint you are adding:

  *Note*

  In the following images, the joints are shown with their two ends split apart. Each end is attached to one of the two joint structures (or a structure and a fixed connection point). Each end of the joint has a set of axes attached to it that corresponds to its position with respect to the structure that it is attached to. The curved, colored arrows in the figures...
below indicate how the two ends will be connected. When the two sets of axes are coincident, the starting position of the structures in the simulation may be different from that in the imported geometry.

- Ball and Socket. Free to rotate about all axes.

**Figure 2.1: Ball and Socket Joint**

- Universal. Free to rotate about two axes transmitting a moment about the third axis at right angles to the first two.

**Figure 2.2: Universal Joint**

- Hinged. Transmitting a moment about two axes and free to rotate about the third axis at right angles the first two.
Figure 2.3: Hinged Joint

- Rigid. Transmitting a moment about all three axes and not free to rotate at all. This type of constraint enables you to find the reactions between two or more structures. This type of joint rigidly connects the structures together so that the solution of the equations of motion is the same as if one structure was defined.

Figure 2.4: Rigid Joint

In order to see the shape of the connections more easily, you can switch to wireframe mode.

- **Connectivity** – Select the type of connectivity for the joint:
  - Fixed Point and Structure
  - Structure and Structure
- **Fixed Point** – For Connectivity of Fixed Point and Structure, select the fixed point from a dropdown list of existing fixed points.
• **Connection Point on Structure (A/B)** – Allows you to select the connection point on the contact structure(s) from a dropdown of existing connection points.

• **Stiffness About X,Y,Z** – These three fields define the rotational stiffness about the X, Y, and Z axes.

• **Damping About X,Y,Z** – These three fields define the rotational damping about the X, Y, and Z axes.

• **Translation Friction Coefficient** – Friction coefficient for transverse force (k1).

• **Rotational Coefficient** – Friction coefficient for overturning moment (k2).

• **Axial Friction Coefficient** – Friction coefficient for axial force (k3).

• **Constant Friction Moment** – Constant friction moment (k4).

The frictional moment is given by:

\[
M = \epsilon \left( k_1 \sqrt{F_y^2 + F_z^2} + k_2 \sqrt{M_y^2 + M_z^2} + k_3 F_x + k_4 \right)
\]

where: \( \epsilon = 0 \) if the relative rotational velocity is less than 0.001 rad/s, 1 otherwise. k1 - k4 are coefficients. Note that these are not conventional dimensionless friction coefficients, as used in the equation \( F = \mu R \). These coefficients are factors to be applied to the appropriate forces to give frictional moments, and they must include effects of the bearing diameter etc. k1 - k3 must not be negative and the maximum value allowed is 0.025.

When inserting a joint, two axis objects are inserted as its children (**Joint Target Axes** and **Joint Contact Axes**). These axes objects define the orientation of the two objects that are connected by the joint. The orientation can be set using these fields in the Details panel for each axes object:

• **Alignment Method** – Select Global Axes to align the axes with the global axes. You can also set the alignment of the axes using the Vertex Selection or Direction Entry methods.

• **Origin Vertex, X Direction Vertex, Vertex Defining the XY Plane** – For an Alignment Method of Vertex Selection, select the **Origin Vertex** of the axis, a vertex defining the X direction (**X Direction Vertex**), and a vertex that would, along with the other two vertices, define the XY Plane (**Vertex Defining the XY Plane**).

• **Rotation about Global Z, Rotation about Local Y, Rotation about Local X** – For an Alignment Method of Direction Entry, define the alignment using these three rotation fields.

---

**Note**

If your joint is connecting the structure to a fixed connection point, it will be indicated by a black sphere. This black sphere is not to be confused with the sphere of a ball and socket joint.

---

### 2.4.5.1. Initial Positioning of Jointed Structures

In hydrodynamic analyses, inserting joints between two structures affects the initial position of these structures when the analysis is run.

The program automatically determines the initial positions based on the defined joints so that you do not have to edit the model's initial geometry. If two connection points are not coincident, the program
moves one of the structures to align the connection points before running the analysis. The geometry movement will not be shown in the viewer.

You can control which structure will remain in a defined position and which structure is free to move by selecting **Connection Point on Structure A** or **Connection Point on Structure B** in the details dialog for the joint. Fixed connections are shown in black.

The rules for defining fixed and movable structures are as follows:

1. If neither of the two is connected to a fixed connection point, the structure with the **Connection Point on Structure A** option will remain at its original position and the structure with the **Connection Point on Structure B** option will be moved.

2. The **Connection Point on Structure A** or **Connection Point on Structure B** designations will be overridden in some situations. If one of two structures is connected to a fixed connection point or is part of a group of articulated structures that are already connected to a fixed connection point, then that structure will remain in a defined position and the other structure will be moved. If this second structure is also part of a group of articulated structures that are not connected to any fixed connection point, the full group to which this structure is already connected will also be moved. Note that this action is independent of the **Connection Point on Structure A** or **Connection Point on Structure B** designations.

3. If one or both of the structures are part of groups of articulated structures and none of these structures is connected to a fixed connection point, then rule #1 applies and the structure with the **Connection Point on Structure B** designation will be moved, along with its group of structures.

4. If both articulated groups are already connected to fixed connection points, the new joint is then going to close the loop. See rules for **Closed Loops** (p. 34) below.

**2.4.5.2. Moving Structures**

Structures are moved in two steps: They are first translated, which causes the joint points to be coincident, and then the structures are rotated so that the two sets of axes attached to the joint object become superimposed. This gives you the freedom to set an initial orientation for the structures at the start of the Time History Analysis. You will not see the structures move in the viewer.

The resulting set of axes defines the local joint axes at the start of the Time History Analysis. In this set of axes, some rotational motion of the structures will be allowed during the Time History Analysis, depending on the type of joint selected:

- **Ball and Socket Joint**: all rotations are allowed.

- **Universal Joint**: rotations are allowed around the X and Y axes of the local axes system.

- **Hinged Joint**: rotations are only allowed around the X axis of the local axes system.

- **Rigid Joint**: no rotation is allowed.

**2.4.5.3. Closed Loops**

In hydrodynamic analyses, the following conditions apply to closed loops in articulated groups of structures:

- The joint positions in the closed loop must be geometrically compatible. It is not possible to connect two structures using two joints if the distance between these joints is different on both structures.
• In some cases, it is recommended that you use a single joint of a different type that will perform the same function as two simpler joints. For example, two ball and socket joints could be replaced by a single hinged joint or two hinged joints could be replaced by a rigid joint.

• A closed loop should not result in any redundancy in the way that the degrees of freedom will be locked. For example, if three articulated structures are connected to form a triangle and two of the joints are of the hinged type with the same orientation for the hinged axis, the third one should be a ball and socket joint because making it a hinged joint would be redundant. The two other hinged joints already prevent one of the rotations for this joint.

**Figure 2.5: A Working Closed Loop**

Figure 2.5: A Working Closed Loop (p. 35) shows a working closed loop consisting of two hinged joints and one ball and socket joint. In this view, the structures that are being joined have been changed to wireframe images to allow the joints to be seen more clearly. The two hinges lock the relative roll and pitch for all three structures. This means that the third joint must have the full range of movement of a ball and socket joint in order to prevent redundancy.
Figure 2.6: A Failed Closed Loop

Figure 2.6: A Failed Closed Loop (p. 36) shows a failed closed loop joining three wireframe structures. The ball and socket joint from Figure 2.5: A Working Closed Loop (p. 35) has been replaced by a third hinged joint. Removing the ball and socket joint has added a useless constraint to the problem. Since all three joints now have limited motion, there is redundancy in the way the degrees of freedom are locked.

When you close a loop, you will get a warning message informing you that a loop is being closed and that this may cause errors while solving. If you are experiencing solver failures when working with closed loops and have followed the rules defined here, please contact the support team for assistance.

2.4.5.4. Removing a Joint

Joints can be removed from an analysis temporarily or permanently by right-clicking on the Joint item in the tree and selecting Suppress or Delete. The result is that the group of articulated structures that contains the joint is broken into two parts. Closed loops that are suppressed or deleted are opened.

If the starting positions of some structures were modified when the joint was created, they will be moved again using the following rules:

- If the two structures are not part of any group, they will be returned to the positions they held when the geometry was created.

- If more than two structures are part of the group to be broken apart, the program positions both subgroup structures where they would have been if the two subgroups had been originally created with the remaining joints. The suppressed and deleted joints are not considered as part of the new arrangement. The existing joints are applied in chronological order.
2.5. Mesh

The mesh is automatically generated on the bodies in the model; its density is based on the defeaturing tolerance and maximum element size parameters.

These parameters apply to the whole structure, although parts or bodies of the structure can be suppressed to prevent unnecessary meshes being created. If suppressed, they will be excluded from the analysis and subsequent result display.

The **Defeaturing Tolerance** controls how small details are treated by the mesh. If the detail is smaller than this tolerance then a single element may span over it, otherwise the mesh size will be reduced in this area to ensure that the feature is meshed. The defeaturing tolerance can not be greater than 0.6 × max element size.

**Max Element Size** controls the maximum size of the element that will be generated. In AQWA this is explicitly related to the maximum wave frequency that can be utilized in the diffraction analysis. If a particular maximum wave frequency is desired then this can be specified instead (**Max Allowed Frequency**) and the associated maximum element size will be computed.

If a smaller element size is required for a particular part or body, then one or many **Mesh Sizing** object(s) can be added to refine the mesh.

The **Meshing Type** option controls the algorithm that is used for the mesh generation. The default is for it to be Program Controlled, in which case, the Surface Only Meshing algorithm is used for parts that only contain surfaces and the Combined Meshing is used if the part also includes lines. If the Program Controlled option fails to produce a satisfactory mesh, then you may control the selection manually.

The larger the maximum element size, the less accurate the results. However, the AQWA solver is limited to 18000 elements, of which 12000 may be diffracting. The number of generated elements is reported, although these exclude any non-meshed elements (e.g. Discs) and elements that may be created automatically if an internal lid is specified.

Furthermore, if the size is set too large and defeaturing is also large, the meshing algorithm may generate single elements at the bow of a ship. This element arrangement is not permitted for AQWA.

Use the toolbar item or context menu to generate the mesh

![Mesh Generate Mesh](image)

---

**Note**

*It is not yet possible to employ symmetry in AQWA, hence the full model must be meshed.*

---

2.5.1. Mesh Sizing

Adding a mesh sizing object enables the refinement of a mesh on a given part or body by enabling a smaller element size to be associated to the geometry. **Local Element Size** can be set once you pick a body on the geometry using **Select Geometry**. Any number of sizing objects can be added to the tree as required.
2.6. Establish Analysis Settings

The **Analysis Settings** object allows you to specify how the analysis runs and how the results are shown. Different fields appear in the Details view for the object depending on the parent object (Hydrodynamic Diffraction or Hydrodynamic Time Response).

The **Sea Grid Size Factor** controls how much larger the sea area is than the structure (or structure group, if there are interacting structures present). The default value of 2 will cause the sea area to be twice as long as the structure in the X or Y directions, a ratio of $X = 1.6 \ Y$ is maintained. This field is only displayed for the Hydrodynamic Diffraction system.

The following sections appear in the Details view for the Analysis Options object:

- 2.6.1. Time Response Options
- 2.6.2. Output File Options
- 2.6.3. QTF Options
- 2.6.4. Common Analysis Options

2.6.1. Time Response Options

The analysis settings in this section of the Detail panel are available for Time Response systems.

**Analysis Type**

Select one of the analysis types listed. Depending upon the type selected, either a regular or irregular wave object needs to be defined for the analysis. Available settings are:

- Irregular Wave Response With Slow Drift (Irregular Wave)
- Irregular Wave Response (Irregular Wave)
- Regular Wave Response (Regular Wave)
- Slow Drift Only (Irregular Wave)

**Start Time, Finish Time**

Set the **Start Time** and **Finish Time** for the Time Response simulation. Then either set the **Time Step** or **Number of Steps** (the other parameter will be updated to reflect the selected value). If there is an upstream Hydrodynamic Time Response system the **Start Time** will automatically be set to the end time of the upstream system.

**Time Step, Number of Steps**

The values of these fields determine the number of steps in the analysis. **Time Step** and **Number of Steps** are interrelated, and an update of one will affect the other to ensure consistency between the entries. Modifying **Time Step** duration will modify the **Number of Steps** and vice versa.

**Starting Position**

If **Starting Position** is set to Program Controlled, the equilibrium position will be determined before the Time Response analysis is started and used as the Starting Position. If the starting position is set to Based on Geometry, the current geometry will determine the Starting Position. If there is an upstream Hydrodynamic Time Response system, then this option will be read only and set to Program Controlled as it is determined by the position at the end time of the upstream system.

**Use Cable Dynamics**

If Yes, enables cable dynamics to be used (can be set per cable). If Cable Dynamics is disabled, then regardless of the selection in the individual cable, it is not used during the analysis.
2.6.2. Output File Options

The analysis settings available in this section of the Details panel control what is written to the AQWA output text file or to specific additional files; refer to the AQWA Reference manual (Help > AQWA Reference from the AQWA Editor menu bar) for more details.

Output ASCII Hydrodynamic Database
If Yes, prints the hydrodynamic database (the .HYD file) in a compact ASCII format to a new file with a .AH1 extension. This option must be set to Yes in order to use the Output Example of Hydrodynamic Database option.

Output Example of Hydrodynamic Database
If Yes, prints a sample of the .AH1 file, with annotation to explain the format.

Output Full QTF Matrix
If Yes, writes an ASCII file AL*.QTF which can be used for external post-processing. The file is in fixed format as follows:

```
AQTF-1.0 :EXAMPLE - FULLY-COUPLED SUMM/DIFF QTF
1 4 3 0.00000 30.00000 45.00000 90.00000
0.3490659 0.4188791 0.5235988
1 4 2 3 -1.4695E-03 4.8995E+05 -7.4829E+03 -1.0434E+07 2.9763E-01 -2.1092E+04
-5.0714E-03 3.1427E+03 -2.0972E+03 -3.4310E+04 5.3036E-02 -2.4030E-01
1.3916E-01 1.1357E+06 1.2190E+03 -8.1649E+06 6.3355E-01 -1.9725E+04
1.0582E-01 7.0678E+05 1.2178E+03 -4.6883E+06 1.0078E+00 -7.8328E+03
etc.
```

Header Record#1:
Columns 1-10 - Reserved for Version Header (AQTF-1.0 :)
Columns 11-80 - Run Title
For each structure:
Logical Record#1:
Columns 1-2 - Structure number.
Columns 3-4 - Number of Directions for this structure.
Columns 5-6 - Number of Frequencies for this structure.
Columns 9-80 - 6 Directions (degrees) PER LINE in field widths of 12. If more than 6 directions are input then columns 9-80 are used on the next line.
Logical Record#2:
Columns 9-80 - 6 Frequencies (radians/sec) PER LINE in field widths of 12. If more than 6 frequencies are input then columns 9-80 are used on the next line up to the total number of frequencies.
Next N*N Logical Records (N=Number of frequencies):
These are 4 lines each where:
Line#1 - Columns 1-2 - Structure number.
Line#1 - Columns 3-4 - Direction number.
Line#1 - Columns 5-6 - First Frequency number.
Line#1 - Columns 7-8 - Second frequency number.
Line#1 - Columns 9-80 - Real part of difference frequency QTF, for 6 d.o.f. (= PD)
Line#2 - Columns 9-80 - Imaginary part of difference frequency QTF, for 6 d.o.f. (= QD)
Line#3 - Columns 9-80 - Real part of sum frequency QTF, for 6 d.o.f. (= PS)
Line#4 - Columns 9-80 - Imaginary part of sum frequency QTF, for 6 d.o.f. (= QS)

Note that the QTF coefficients, normally referred to as P (real) and Q (imaginary), are in 'standard format'. If i is the 1st frequency and j is the second, then P(i,j) coefficients are symmetric and Q(i,j) coefficients are anti-symmetric i.e. P(i,j)=P(j,i) and Q(i,j)= - Q(j,i).

The force time history is therefore given by:

\[ F = FD \cos((w2-w1)t+P1) + FS\cos((w1+w2)t+P2) \]

Where:

\[ FD = \sqrt{PD^2+QD^2} \]
\[ FS = \sqrt{PS^2+QS^2} \]

w1 = 1st frequency
w2 = 2nd frequency
P1 = ATAN2(QD,PD)
P2 = ATAN2(QS,PS)

Do not output .LIS banner page
If Yes, disables printing of the banner page in the *.LIS file.

No data list
If Yes, disables all extended data output in the *.LIS file.

Output Element Properties
If Yes, writes complete details of each element used in the body modelling to the *.LIS file. All important details of the body elements are output together with the resultant properties of the bodies.

Output Source Strengths
If Yes, writes the singularity strengths for both the modified and unmodified values to the *.LIS file, the modified strengths being a linear combination of the unmodified values. The actual relationship is a function of the number of body symmetries that are used.

Output Potentials
If Yes, writes the modified and unmodified values of the potential at the diffraction element centres and at the field points to the *.LIS file. This information may be used to define the fluid flow field about the body.
Output Centroid Pressures
If Yes, writes the total hydrostatic and hydrodynamic fluid pressures at each plate in the model to the *.LIS file.

No Statistics
If Yes, stops the automatic calculation of statistics at the end of each simulation run. Statistical processing can be lengthy for long simulations. This option can be used to reduce processing time if statistics are not required.

No wave elevation at field points
If Yes, disables the writing of field point wave elevation in the .LIS file.

2.6.3. QTF Options

The analysis settings available in this section of the Details panel control the QTF output; refer to the AQWA Reference manual (Help > AQWA Reference from the AQWA Editor menu bar) for more details.

Calculate Full QTF Matrix
If Yes, specifies calculation of the full QTF matrix.

Use Full QTF Matrix
If Yes, specifies that the full matrix of difference frequency QTFs is to be used when calculating slowly varying drift forces.

Use Sum Frequency QTFs
If Yes, specifies that the full matrix of sum frequency QTFs is to be used when calculating slowly varying drift forces, in addition to using the full matrix of difference frequency QTFs. You must also have Use Full QTF Matrix set to Yes to use this feature.

2.6.4. Common Analysis Options

The analysis settings available in this section of the Details panel control how the analysis is performed. In normal circumstances they will not need adjusting; however, if you get modelling warnings then you may wish to turn on the "Ignore modelling rule violations" option. Refer to the AQWA Reference manual (Help > AQWA Reference from the AQWA Editor menu bar) for more details.

---

Note
Options appear based on the configuration of the analysis. Not all of the options below will be visible for a particular Analysis Settings object. Options are listed below in alphabetical order to make them easier to find.

Calculate C.I.F. Using Added Mass and Damping
If Yes, calculates the Convolution Integral Function based on both added mass and damping. The default method for calculation of the Convolution Integral Function uses the radiation damping only.

Calculate Motions Using RAOs Only
If Yes, calculates motions using RAOs only. Note that this option suppresses all motion except that defined by the RAOs. In particular current, wind, drift forces, moorings etc. have no effect on the motions of the structure.
Call Routine “user_force”
If Yes, calls a routine called “user_force” at each stage of the calculation. This routine can be used to add externally calculated forces to the simulation.

Convolution
If Yes, specifies that convolution method is used in radiation force calculation. This is a more rigorous approach to the radiation force calculation in time domain and will enhance the capability of handling nonlinear response of structures.

Ignore modelling rule violations
If Yes, continue the analysis in spite of the modelling rule violations. Most of the modelling errors will be turned into warnings by this option. Do not use this option unless the violations are minor and difficult to correct.

Linearized Tube Drag
If Yes, computes linearized tube drag. In order for the drag to be computed, after enabling Linearized Tube Drag an Irregular Wave must be added to the Hydrodynamic Diffraction analysis. Only one spectrum can be defined (no Irregular Wave Group). The Irregular Wave must have only a single direction defined (no Cross Swell).

As this option is only available when analyzing a single structure, it will not show up when the Structure Selection contains more than one structure. If it's set to Yes and a new structure is added, it will show as a yellow field and the "Analysis Options" item will be marked with the question mark until either the number of structures in the structure selection is set back to one or the option is set to No.

Near field solution
If Yes, specifies that the near field solution should be used in the calculation of mean drift force. By default the far field solution is used, which only calculates the mean drift force in three horizontal degrees of freedom (i.e. surge, sway and yaw). The far field solution is also unable to consider the hydrodynamic interaction between structures.

No Automatic Wave Drift Damping Calculation
If Yes, stops the automatic calculation of wave drift damping for a floating structure. Note that the wave drift damping calculated by the program is only for the floating structure, damping from risers, etc. is not included.

No Current Phase Shift
If Yes, switches off the wave phase shift due to a current speed.

No drift coefficients
If Yes, disables the Mean Wave Drift Force calculations.

No pressure post-processing
If Yes, specifies that there will be no pressure post-processing and therefore the connectivity warnings can be omitted.

No Yaw Wave Drift Damping
If Yes, suppresses the calculation of wave drift damping for yaw motion. To prevent the calculation of all wave drift damping use the No Automatic Wave Drift Damping Calculation option.
**Tube Drag Coefficients**

If set to Defined in Geometry, uses the **Viscous Drag Coefficient** fields of the Line Body objects in the Geometry. If set to **Reynolds Number Dependent**, causes drag coefficients to be calculated using the Wieselburger graph of drag coefficient versus Reynolds Number.

![Drag Coefficients versus Reynolds Numbers for Circular Cylinder](image)

**Scale Factor for Model Test Simulation**

Only available if **Tube Drag Coefficients** is set to Reynolds Number Dependent. Set to unity (default) to provide simple Reynolds Number dependent drag calculations using the Wieselburger curve. If comparisons against scaled model tests are to be undertaken, then provide the scale factor of the model here. For example, if the scaled model is 10:1 then specify a factor of 10.

The scale factor is used as follows:

\[
\text{Local Reynolds Number} = \frac{(UD/\nu)}{(\text{Scale Factor}^{3/2})}
\]

where:

- \(U\) = Local velocity transverse to the axis of the TUBE
- \(D\) = The diameter of the TUBE
- \(\nu\) = Kinematic viscosity of water

**Use Linear Starting Conditions**

If Yes, starts a simulation with the motions and velocities derived from the Hydrodynamic Diffraction system results. This can be used to limit the transient at the start of a simulation.

**Use Linear Stiffness Matrix to Calculate Hydrostatic**

If Yes, uses the linear stiffness matrix rather than recalculating the hydrostatic stiffness from the hydrostatic element model. This normally will reduce the time to run the program substantially.

**Use Slow Velocity for Hull Drag Calculation**

If Yes, uses the slow velocity (drift frequency velocity) for the hull drag calculation, instead of the total velocity (drift frequency velocity + wave frequency velocity) which is the default.
2.7. Applying Ocean Environment and Forces

The following ocean environment and forces objects can be added to your analysis (or may be included with your analysis by default). Some are restricted to the Hydrodynamic Diffraction analysis and some are restricted to the Hydrodynamic Time Response analysis.

2.7.1. Structure Selection
2.7.2. Gravity
2.7.3. Wave Directions
2.7.4. Wave Frequencies
2.7.5. Structure Force
2.7.6. Regular Wave
2.7.7. Irregular Wave
2.7.8. Irregular Wave Group
2.7.9. Current
2.7.10. Wind
2.7.11. Cable Winch
2.7.12. Cable Failure

2.7.1. Structure Selection

The Structure Selection tree object enables the definition of interacting structures, in addition to any structures that you want to exclude for this particular analysis. It also enables the structure order to be changed.

Structures can be selected graphically (use the CTRL key to select more than one) for inclusion in a group or to be excluded from the analysis. To include structures in a group, click on an Interacting Structure Groups field. To exclude structures from the analysis, click on the Structures to Exclude field. Select the structures in the model, then click the Apply button. The selected structures will be listed in the field. If a structure is excluded, then it will automatically be removed from any groups and the structure order. A structure may only be included in one interacting structure group.

By default, when AQWA is first started all parts will be considered to be hydrodynamically interacting and will be included in the analysis. If a part is subsequently suppressed, it cannot be used in the analysis, and is automatically excluded in the Structure Selection. However, when a part is then unsuppressed, it must be manually added to the Structure Selection in order for it to be included in the analysis. If hydrodynamic interaction is required then this must also be established manually in the Structure Selection.

If a structure has been removed from the analysis and you want to add it back in, you must reselect the set of Structures to Exclude. If you want all structures to be included in the analysis, you may click on the field next to Structures to Exclude then click Apply with no structures selected.

The AQWA solver requires that a group of interacting structures be consecutively ordered for the analysis. Set the structure ordering so that all structures in a particular interacting group are listed sequentially. For example, if you have 4 structures named A, B, C, and D, structure C is excluded, and structures A and D are in an interacting group, you must list structures A and D sequentially in the Structure Ordering section of the Details panel. In this case, the order could be (A, D, B) or (B, D, A), but it could not be (A, B, D).

There are some limitations on the number of interacting structures and the total number of structures:

- There is a maximum number of 20 interacting structures in any group.
• The total number of structures must be less than or equal to 50.

• The number of added mass sub-matrices must be less than or equal to 430. This is calculated by summing the squares of the number of structures in each group and adding to that the number of non-interacting structures.

**Note**

Suppressing/unsuppressing a structure from the right click menu on the tree or the Details panel of the structure affects the structure's status in the Structure Selection. If you suppress a structure and then unsuppress it, you must go to the Structure Selection object and remove it from the excluded structures set in order for it to be included in the analysis.

### 2.7.2. Gravity

This tree object enables the definition of Gravity for this analysis; changes can be made if you want to try to match another analysis.

### 2.7.3. Wave Directions

The Wave Directions tree object enables the definition of a range or single wave direction to use in the analysis.

If **Type** is set to Single Direction, Forward Speed, you can enter a structure **Forward Speed** and a **Wave Direction**. In this case, only a single wave direction can be analyzed.

If **Type** is set to Range of Directions, No Forward Speed, waves are automatically created in -180 and +180 directions, and either the **Interval** or the number of intermediate directions (**No of Intermediate Directions**) can be specified. If a direction range is of particular interest, additional ranges or specific directions can be added.

To add Optional Wave Directions, select Single or Range from the **Additional Range** dropdown. For the Single direction, specify the **Start Angle**. For a Range of directions specify the **Start Angle, End Angle**, and either the **Interval** or **No of Intermediate Directions**.

Duplicated directions will automatically be removed; although the number of directions does not contribute greatly to the analysis time, there is a limit imposed of a total of 41 directions for any one structure.

**Note**

*It is not possible to employ symmetry in AQWA.*

### 2.7.4. Wave Frequencies

The Wave Frequencies tree object enables the definition of a range or single wave frequency to use in the analysis.

By default the frequency **Range** is Program Controlled; this equally spaces the specified **Total Number of Frequencies** between a minimum value based on the **water depth** and a maximum based on the **mesh size**. The spacing interval can either be based on constant frequency or constant period increments (**Equal Intervals Based Upon**).
You can manually define one or more single frequencies or range of frequencies by selecting Manual Definition for the Range. For a single frequency, set Definition Type to Single. Enter the Lowest Frequency or Longest Period.

To specify a range of frequencies, set Definition Type to Range. Enter a Lowest Frequency and Highest Frequency, or a Longest Period and Shortest Period.

The start frequency will default to 0.1 rad/s and the end frequency will default to that determined by the mesh. The maximum wave period (and equivalent frequency) permitted is 200s.

The intermediate positions can be defined either by a constant frequency or period, or by entering a number of values. Set Interval Type to Frequency or Period, and use No of Intermediate Values or Interval Frequency to specify intermediate positions. If a number of intermediate values are chosen, they will be equally spaced depending upon the interval type.

To specify additional frequencies, set Additional Range to Single or Range and enter the Period/Frequency and Interval information. Any duplicate frequencies will be automatically removed. The number of frequencies chosen extends the solution time linearly.

---

**Note**

If a mesh size is modified after the creation of the frequency object, the maximum frequency is not altered and may need to be updated manually.

---

### 2.7.5. Structure Force

A time history of structure forces applied at the center of gravity can be defined directly in a table or by importing the data from an existing .XFT file. To define the data directly in the table, right click on the Hydrodynamic Time Response object and select Insert > Structure Force > Manual Input. To read the data from a file, select Insert > Structure Force > Import XFT File... and browse to the file location. You can also insert the object by clicking Structure Force on the Analysis toolbar and selecting one of the options.

---

**Note**

After the data is imported, no record of the file used to import the data is retained.

---

In the Details panel, the column definition can be associated to the appropriate structures in the model. A row has to be filled in for all structures; additional rows can be added to the end of the table and they will be automatically re-sorted once entry is complete. Position data can also be copied and pasted from an appropriate external source.

**Defining the .XFT file**

The time defined in the data does not need to match the time step defined in the analysis; the program will interpolate the forces when necessary, using a cubic spline interpolation technique. When modelling periods of constant force adequate data points must be provided to satisfy the interpolation method. There is no limit on the length of the .XFT file.

It is important to note that the forces defined in the .XFT file are in six degrees of freedom for each structure and are in the global axis system.
Comment lines are permitted at any point in the file and must begin with *.

The first line (comments excepted) in the file ought to contain the structures information; this indicates the structure numbers that the columns correspond to. For example, when there are 3 structures, this line could be structures=1 3 9. The structure numbers can be determined from the AQWA Editor by reviewing the Structure Selection in the upstream Hydrodynamic Diffraction analysis.

Before the data defining the time and forces, there must be a line containing only the text, data_start.

After the data start, the first column contains time, and subsequent columns (in sets of 6) indicate the forces for specified structures. The forces are ordered as follows, using global directions: X, Y, Z, RX, RY, RZ. The numbers in the .XFT file are in a free format and can be separated by spaces.

An example of the data in a file would be:

```
structures=1
data_start
0.0000 4.4800E+05 5.0400E+06 3.1360E+06 5.0400E+07 8.9600E+06
0.5000 4.3978E+05 4.9689E+06 3.0784E+06 4.9689E+07 8.7956E+06
1.0000 4.1592E+05 4.8207E+06 2.9114E+06 4.8207E+07 8.3183E+06
...```

### 2.7.6. Regular Wave

The Regular Wave object is used for Time Response analyses. Regular Waves can only be applied when the **Analysis Type** under the Time Response Analysis Setting object is set to Regular Wave Response (rather than the default value of Irregular Wave Response). If a parameter is selected, it will appear in the Workbench Parameter Set. To insert a regular wave, click on the Hydrodynamic Time Response object and select **Insert > Regular Wave**, or select **Regular Wave** from the Analysis toolbar.

Set **Wave Type** to Airy Wave Theory or Stokes 2nd Order Wave Theory for the calculation of the Froude-Krylov forces. Airy Wave Theory is not recommended to model big waves. Enter the **Direction** and **Amplitude** of the wave. The direction is shown in the graphics with an arrow (light blue).

Enter a **Period** or **Frequency** for the wave. The period / frequency in general should be within the range of that in the Hydrodynamic Diffraction analysis.

---

**Note**

Both Frequency and Period are enabled as parameters, but in practice you would only choose one of these two to be parameterized (as Period = 1/Frequency). If you were to parameterize both and then enter values from the Project Page that don't conform to this relationship, only one of the values will be used and the other ignored.

The wave ramp is introduced to reduce the transient motion of the structure at the beginning of a time domain analysis. The wave ramp will take effect from t=0.0 to t = t_w, during which time a wave ramp factor f (0.0 < f < 1.0) will be calculated and then used to multiply the incident wave amplitude. The wave ramp factor f is

\[ f = \sin^2 \left( \frac{\pi t}{2t_w} \right) \]
It can be seen that at $t=0$, the factor is 0.0 and at $t=t_w$, the factor is 1.0. If Ramping Method is set to Program Controlled, $t_w$ will default to the wave period. For Defined Ramping, Set the Ramping Factor to the desired time $t_w$.

### 2.7.7. Irregular Wave

An irregular wave can be added to the Hydrodynamic Time Response system, either individually or as part of an Irregular Wave Group. In addition, it can be added to the Hydrodynamic Diffraction system when Linearized Tube Drag is specified for the analysis (only a single irregular wave can be used in the Hydrodynamic Diffraction system, and no Cross Swell should be specified).

#### Note

Although you can add multiple irregular wave groups and individual irregular waves to your analysis, you must have only one active in order for the analysis to solve; the others must be suppressed.

To insert an irregular wave, right-click on the Hydrodynamic Time Response or Hydrodynamic Diffraction object and select Insert > Irregular Wave > wave type, or select Irregular Wave > wave type from the Analysis toolbar. The available wave types are listed below. The following parameters are available in the Details panel for all irregular wave types.

**Direction of Spectrum** is the direction of waves within a wave spectrum.

**Seed Definition** defines the random seed for a wave spectrum. The options available are Program Controlled or User Defined. If you select User Defined, you can set the seed value.

**Omit Calculation of Drift Forces** disables the mean drift force calculations for the current spectrum. Select Yes to disable the calculations and No to have them applied.

The user should, in general, specify a spectral sea state whose range of frequencies is less than the range for which the hydrodynamic parameters for the structure are defined (those specified in the Wave...
**Frequencies** object). At spectrum frequencies which are outside the range at which the hydrodynamic parameters are defined, the program will automatically extrapolate the values required.

The effects of cross swell are implemented in most of AQWA. Select the **Cross Swell Spectrum** type in the **Cross Swell Details** section of the **Details** panel. The **Cross Swell Spectrum** can be different from the current **Wave Type**. However the parameters used to define the **Cross Swell Spectrum** are the same as those for the corresponding spectrum **Wave Type**, except that the start and finish frequencies are calculated by the program.

For all wave types except User Time History and User Spectra (1D), set **Wave Range Defined by** to either Period or Frequency. Next, set **Start and Finish Frequency/Period Definition**. The available options are:

- Program Controlled - both Start Frequency/Period and Finish Frequency/Period (default)
- Start Frequency/Period User Defined - Finish Frequency/Period Program Controlled
- Finish Frequency/Period User Defined - Start Frequency/Period Program Controlled
- User Defined - both Start Frequency/Period and Finish Frequency/Period

**Start Frequency/Period** is the lowest frequency or longest period at which the spectrum is defined and **Finish Frequency/Period** is the highest frequency or shortest period at which the spectrum is defined. Enter values in the fields that are user defined, based on the **Start and Finish Frequency/Period Definition** setting.

The following wave types are available:
- **2.7.7.1. Jonswap (Hs or Alpha)**
- **2.7.7.2. Pierson-Moskowitz**
- **2.7.7.3. Gaussian**
- **2.7.7.4. User Spectra (1D)**
- **2.7.7.5. User Time History**

### 2.7.7.1. Jonswap (Hs or Alpha)

The Jonswap wave spectrum can be used to describe a wave system where there is an imbalance of energy flow (i.e. sea not fully developed). This is nearly always the case when there is a high wind speed. It may be considered as having a higher peak spectral value than the Pierson-Moskowitz spectrum but is narrower away from the peak in order to maintain the energy balance.

If you choose **Jonswap (Hs)** as the Wave Type, **Significant Wave Height** will be used in the calculations rather than the parameter **Alpha**, (which is used when the Wave Type is set to **Jonswap (Alpha)**).

Parameterization of the classic form of the Jonswap spectrum (with parameters of fetch and wind speed) was undertaken by Houmb and Overvik (BOSS Trondheim 1976, Vol 1). These empirical parameters (which you must enter) are termed **Gamma** ($\gamma$), **Alpha** ($\alpha$) and **Peak Frequency** ($\omega_p$) (the frequency at which the spectral energy is a maximum). The peak frequency together with empirical parameters termed Gamma and Alpha are used in this formulation. The spectral ordinate ($S$) at a frequency ($\omega$) is given by

$$S(\omega) = \frac{\alpha \omega^2 \omega_p^\alpha}{\omega^5} \exp \left( -5 \frac{\omega^4}{4 \omega_p^4} \right)$$
where \( \alpha = \) a constant decided by \( H_s, \omega_p, \) and \( \gamma \)

\[ g = \text{acceleration due to gravity} \]

\[ \omega_p = \text{peak frequency} \]

\[ \gamma = \text{peak enhancement factor} \]

**2.7.7.2. Pierson-Moskowitz**

The Pierson-Moskowitz spectrum is formulated in terms of the two parameters of **Significant Wave Height** (\( H_s \)) and average **(Zero Crossing Period)** wave period (\( T_z \)). This is considered of more direct use than the classic form, in terms of the single parameter wind speed, or the form involving the peak frequency, where the spectral energy is a maximum. The spectral ordinate (\( S \)), at a frequency (\( \omega \); in rad/sec), is given by

\[
S(\omega) = \frac{1}{2\pi^4 \sigma H_s^4} \left( \frac{2\pi}{\omega} \right)^5 \exp \left( -\frac{1}{\sigma^4} \left( \frac{2\pi}{\omega} \right)^4 \right)
\]

The average (i.e. mean zero-crossing) wave period **(Zero Crossing Period)** and **Significant Wave Height** are the parameters used to describe the Pierson-Moskowitz wave spectrum, the special case for a fully developed sea.

**2.7.7.3. Gaussian**

The standard Gaussian spectrum is given by

\[
S(f) = \left( \frac{H_s/4}{\sigma \sqrt{2\pi}} \right) \exp \left( -\frac{(f - f_p)^2}{2\sigma^2} \right)
\]

where

\( H_s \) is significant wave height

\( f_p \) is peak frequency

\( \sigma \) is standard deviation

The **Peak Frequency**, **Significant Wave Height**, and **Sigma** (\( \sigma \)) are the parameters used to describe the Gaussian wave spectrum. The maximum value of \( \sigma \) is capped at 0.08\( f_p \).

**2.7.7.4. User Spectra (1D)**

This option may be used to input any user-defined spectrum. It is normally employed for input of non-deterministic spectra such as tank spectra, recorded full-scale spectra, or simply where the formulated spectrum is not yet available. In the User Wave Spectrum Definition Data table, enter the frequency (or period, depending on the **Wave Range Defined by** setting) and its corresponding spectral ordinate. The maximum number of frequencies/periods is 25.
2.7.7.5. User Time History

A time history series of wave elevations may be imported into your Hydrodynamic Time Response analysis, in order to reproduce model test wave conditions as accurately as possible. Select Insert > Irregular Wave > Import WHT File..., or select Irregular Wave > Import WHT File... from the Analysis toolbar, and browse to the file location.

**Note**

After the data is imported, no record of the file used to import the data is retained.

When drift effects are included in the analysis the wave elevation time-history will be reproduced exactly, within the frequency range of the fitted spectrum and subject to the limitations of roundoff error. This is achieved by multiplying each of the spectral wavelets by a different Low Frequency Perturbation (LFP) Function; i.e.:

\[
\text{Wave elevation} = \sum_{j=1}^{N} \{ a(j) \cos(-w(j)t+k(j)x+i(j)) \times \text{LFP}(j)(t) \}
\]

where:

- \( N \) = number of spectral lines (set to 200)
- \( j \) = wavelet number
- \( t \) = time
- \( w \) = frequency (as normally output by the AQWA solver)
- \( i \) = phase (as normally output by the AQWA solver)
- \( a(j) \) = amplitude
- \( k \) = wave number

Note that no spurious low frequency waves are generated by the above method. For any wavelet, the minimum frequency present in the wave elevation is \( w(j) - dw \), where \( dw \) is the highest frequency present in the LFP function. Note also that there is no frequency overlap for each wavelet. Each LFP
function can be considered as a frequency spreading function over a limited set of contiguous frequency bands. In this case each wavelet has a different energy (as opposed to the standard AQWA wavelets which have equal energy).

Import of the time series will also generate a user-defined spectrum, using a Fast Fourier Transform, whose frequency range is based on a Jonswap fit of the wave elevation spectral density. If drift effects are ignored, this spectrum will be used in the same way as a normal user-defined spectrum. As the phases of the spectral wavelets are allocated randomly, the input wave elevation time history will not be reproduced.

**Note**

Current is ignored when calculating the phase wave forces on the structure and the wave kinematics for Morison elements.

The *.WHT file is an ASCII file with the wave elevation data in free format with 2 values per line. The first value is the time and the second value is the wave elevation.

The following 2 statements are required in the file:

```
DEPTH=value
G=value
```

The DEPTH value must be the same as the Water Depth specified in the Geometry Details or else an error will be generated. The G value is compared to the Gravity specified in the Gravity object Details to determine the units used.

The following optional data can also be input. If any are omitted, the relevant value defaults to zero.

```
DIRECTION=value(degrees)
X_REF=value
Y_REF=value
NAME=Spectrum Name
CURRENT_SPEED=value
CURRENT_DIRECTION=value(degrees)
```

**Note**

- The X_REF and Y_REF values are used in the calculation of the phase of the wave and are the position where the wave elevation was measured. For example (in SI units), if the DIRECTION of the wave is zero degrees (in other words, along the positive X-axis in the global coordinate system) then values of X_REF/Y_REF of 100.0/0.0 will indicate that the wave elevation was measured 100 metres downstream of the 0,0 wave reference point. Omission of these data will default the reference point to 0,0, i.e. the wave elevation will be calculated using the origin of the global coordinate system as the point at which the wave elevation will be reproduced. X_REF, Y_REF and DIRECTION values appear in the Details panel for the Wave object.

- The Spectrum Name will be used for graphs and tables where appropriate throughout the program, and is appended to the Wave object name in the tree.

- CURRENT SPEED and CURRENT DIRECTION are needed for calculation of the wavelengths of the wavelets used to reproduce the wave elevation. If present they must match the corresponding values in the unsuppressed Current object in the tree (if there is no Current object, an error will be generated.) If omitted, it is assumed that there is no current and a warning will be issued.
• The duration of the time history in the file should be at least 7200s. This duration is necessary in order to give sufficient resolution of low frequency resonant responses. If the file contains less data than this, the data will be extended automatically up to 7200s, using a process of mirroring and copying.

• The maximum number of timesteps in the .WHT file is 150000.

• Comments (starting with * in Column 1) may be added anywhere in the file.

An example of a *.WHT file is shown below.

```
* This is an example of a *.wht file
* DEPTH=30.0
  G=9.81
  DIRECTION=0.0
  X_REF=100.0
  Y_REF=0.0
  NAME=EXAMPLE
  CURRENT_SPEED=0.6
  CURRENT_DIRECTION=90
  * TIME WAVE HT
  * s m
  0.0000 -1.088
  0.2366 -1.188
  0.4732 -1.268
  0.7098 -1.351
  0.9464 -1.427
  1.1830 -1.471
  1.4196 -1.494
  1.6562 -1.476
  1.8928 -1.406
  2.1294 -1.293
  2.3660 -1.149
  2.6026 -0.966
  ETC.
```

2.7.8. Irregular Wave Group

The Irregular Wave Group allows you to include multiple irregular waves in your analysis. To insert a wave group, right click on the Hydrodynamic Time Response object and select Insert > Irregular Wave Group, or click on the Hydrodynamic Time Response object and from the Analysis toolbar select Irregular Wave > Irregular Wave Group. After the wave group object is inserted, right click on it and select Insert > Irregular Wave > wave type, or click on the wave group object and from the Analysis toolbar select Irregular Wave > wave type. Define the options of each individual wave spectra in the group after you add them.

Note

• Although you can add multiple irregular wave groups and individual irregular waves, you must have only one active in order for the analysis to solve; the others must be suppressed.

• There are limits on the total number of irregular waves you can insert in a group. The total number of spectra is 41; an irregular-wave of formulated type (Pierson-Moscowitz, Jonhswap) counts for 1 (or 2 if you add Cross-Swell), imported wave time history counts for 1 (but you can only have a maximum of 5 imported history), and user defined counts for 1 as well.
2.7.9. Current

Current can be modelled to supplement the wave forces being applied to the structure. This can either be a simple constant entry or a range of depths, velocities, and directions. Current loading is applied to the hull of a vessel if hull drag coefficients have been provided and will utilize the current at a specified depth. Current loading will be applied to tubular beams and stub elements using the velocities at the depth of the element. If cable dynamics is used for the definition of a composite catenary cable, current loading will also be applied along the length of the cable using the variable current velocity with depth.

To insert a Current object, right click on the Hydrodynamic Time Response object and select Insert > Current, or click on the Hydrodynamic Time Response object and from the Analysis toolbar select Current. To enter the current data, click on the Current object to open the Current Definition Data table.

For a constant current, make a single entry in the table that defines the current Velocity and Direction, and provide any Depth value that is between 0 and the water depth. A 0 degree direction defines the current flowing in the positive X direction, 90 degrees defines it flowing in the positive Y direction. This value will be used for the full depth as defined by Water Depth in the Geometry object.

```
<table>
<thead>
<tr>
<th>Details</th>
<th>Current Definition Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Depth (m)</td>
</tr>
<tr>
<td>Name</td>
<td>30</td>
</tr>
<tr>
<td>Visibility</td>
<td>Visible</td>
</tr>
<tr>
<td>Activity</td>
<td>Not Suppressed</td>
</tr>
</tbody>
</table>
```

For a variable current, enter multiple rows containing information for the current Velocity and Direction at each Depth.

```
<table>
<thead>
<tr>
<th>Details</th>
<th>Current Definition Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Depth (m)</td>
</tr>
<tr>
<td>Name</td>
<td>1</td>
</tr>
<tr>
<td>50</td>
<td>2.2</td>
</tr>
<tr>
<td>150</td>
<td>2.0</td>
</tr>
<tr>
<td>200</td>
<td>0.0</td>
</tr>
<tr>
<td>Visibility</td>
<td>Visible</td>
</tr>
<tr>
<td>Activity</td>
<td>Not Suppressed</td>
</tr>
</tbody>
</table>
```

Depth is measured from the sea surface. Depth values must be positive numbers and less than the depth of water. If a complete definition of current with depth is not defined between the water surface and depth of water, constant values will be assumed based upon the lowest and highest defined data. So, in the example above, and assuming a water depth of 250m the current values at a depth of 0 (the water surface) will be a velocity of 2.5 m/s and a direction of 45 degrees, and at the sea bed the velocity will be 0.

If there are multiple rows in the table, there will be a number of arrows to represent the current direction and speed at various depths; these will be purple if valid, or yellow if invalid. For a constant current, a single arrow is shown at the depth defined in the Current Definition Data table. The arrows are scaled with speed.
For each structure (Part), the depth at which the current velocity is calculated (Current Calculation Depth) for the hull loading can be entered in the Part details; again, this should be a positive number.

**Note**

- Current cannot be parameterized.
- If a User Time History of wave elevations is imported using a WHT file, it may be necessary to define the current profile with negative velocities.

### 2.7.10. Wind

To supplement the wave forces being applied to the structure, wind forces can be modelled. Wind can be modelled using a number of spectrum options (including user defined), user time dependent data, or constant velocity. The wind is shown in the graphic by an arrow at the reference height (or at ht = 0, if not applicable), scaled with speed. To insert a Wind object in your Time History analysis, right click on the Hydrodynamic Time History object, then select Insert > Wind > wind type, or click on the Hydrodynamic Time Response object and from the Analysis toolbar select Wind > wind type. The available wind types are:
• Constant Velocity
• Time Dependent Velocity
• Ochi and Shin Spectrum
• API Standard Spectrum
• NPD Standard Spectrum
• ISO Standard Spectrum
• User Defined Spectrum

The wind type of Constant Velocity is permitted for any wave type. Enter the Speed and Direction of the constant wind in the Wind Spectral Definition section of the Details panel.

The wind types (Ochi & Shin, API, NPD, ISO, and User Defined) are only permitted for analysis types that permit irregular waves. The following options are shown in the Details panel for all of the spectra, except User Defined (multiple sets of these options are defined for Time Dependent Velocity). Enter the Reference Height at which the wind speed is measured, the Speed of the wind at the reference height, and the Direction of the wind spectrum.

For a User Defined spectrum, in addition to the Reference Height, Speed, and Direction, you need to enter the following in the Details panel:

• Frequency Coefficient
• Speed Coefficient - surface drag coefficient or roughness
• I(z) - turbulence intensity

In the Data panel, you need to enter in each row of the table a dimensionless frequency f and its associated spectral ordinate U(f). For user-defined spectra, the dimensionless frequency is defined as f = cf * z/Uz F, where F is the frequency in hertz. The wind speed spectral density is defined as S(F) = cs * U(f) * (I(z)*Uz)**2/F. Only 25 rows may be entered.
The following wind spectra are described in more detail:

2.7.10.1. Ochi and Shin Spectrum
2.7.10.2. API Standard Spectrum
2.7.10.3. NPD Standard Spectrum
2.7.10.4. ISO Standard Spectrum
2.7.10.5. User Defined Spectrum
2.7.10.6. Time Dependent Velocity

2.7.10.1. Ochi and Shin Spectrum

The ordinate of this wind spectrum is calculated from the paper by M.K.Ochi and Y.S.Shin OTC 5736 (1988) to which the user should refer for more details. The non-dimensional wind spectrum $S(f)$ is given by:

- for $0.000 < f < 0.003$, $S(f) = 583 f^{2}/0.003$
- for $0.003 < f < 0.100$, $S(f) = 420 f^{0.7}/(1+f^{0.35})^{11.5}$
- for $0.100 < f$, $S(f) = 838 f/(1+f^{0.35})^{11.5}$

We note that the peak occurs at approximately $f = 0.0117$ where $S(f) = 2.0685$. At $f=1.0$, $S(f)$ is approximately 14% of the peak value.

where:

- $f$ = Non-dimensional frequency = $F*z/U_z$
- $S(f)$ = Non-dimensional wind spectrum = $F*S(F)/U_x^{2}$
- $F$ = Frequency in hertz
- $z$ = Elevation
- $U_z$ = Wind speed at elevation $z$
- $S(F)$ = Wind speed energy density
- $U_x$ = Shear velocity

The wind speed, elevation $z$, and the shear velocity are given by:

$U_z = U_{10} + 2.5 * U_x \ln(0.1*z)$
Ux = U10 * sqrt(C10)

C10 = 0.000794 + 0.00006658 * U10

where:

U10 = Wind speed at reference elevation of 10 metres.

**2.7.10.2. API Standard Spectrum**

The API wind spectrum is a simple non-dimensional one as defined below. Note that in later versions of API standards the recommended spectrum is the NPD spectrum.

**Mean Profile**

The mean profile for the wind speed averaged over 1 hour at elevation z, Uz, can be approximated by:

\[ Uz = U10 \times \left(\frac{z}{zr}\right)^{0.125} \]

where:

U10 = Wind speed averaged over 1 hour at reference elevation of 10 metres

zr = 10 metres

**Gust Factor**

The gust factor G(t,z) can be defined as:

\[ G(t,z) = \frac{Uz(t)}{Uz} = 1 + g(t)I(z) \]

where:

I(z) = turbulence intensity (see below)

t = gust duration (seconds)

The factor g(t) is given by:

\[ g(t) = 3.0 + \ln\left((3/t)^{0.6}\right) \text{ for } t < 60 \text{ seconds.} \]

**Turbulence Intensity**

Turbulence intensity is the standard deviation of wind speed normalized by the mean wind speed over 1 hour. Turbulence intensity can be approximated by:

\[ I(z) = \frac{s(z)}{Uz} \]

\[ = 0.15 \times \left(\frac{zs}{z}\right)^{0.125} \text{ for } z < zs \]

\[ = 0.15 \times \left(\frac{zs}{z}\right)^{0.275} \text{ for } z > zs \]

where:

zs = 20m (66 feet) = thickness of the "surface layer"
We note that the turbulence intensity at 10m is 0.1636, or, the ratio of U10/standard deviation(at 10m) is 6.112 (1.0/0.1636)

**Wind Spectrum**

$$S(f) = f/(1+1.5f)^{(5/3)}$$

where:

$$f = \text{non-dimensional frequency} = F/f_p$$

Measured values of $f_p$ show a wide variation. An average value, given by:

$$f_p = 0.025*U_z/z$$

is currently used in AQWA, i.e.

$$f = 40 F*z /U_z$$

The spectral energy density $S(F)$ is given by:

$$S(F) = s(z)^{2} * S(f)/F$$

We note that, by definition, the integral(0 to infinity) of $S(f)/F$ is unity.

**2.7.10.3. NPD Standard Spectrum**

This spectrum is based on the NPD spectrum as defined in API RP2A, 21st edition with supplements. In the following, all quantities are measured in SI units (m, m/s).

**Mean Profile**

The mean profile for the wind speed averaged over 1 hour at elevation $z$, $U_z$, can be approximated by:

$$U_z=U_{10}*[1 + C(ln(z/10))]$$

where:

$U_{10} = \text{Wind speed averaged over 1 hour at reference elevation of 10 metres}$

$C = 0.0573*\sqrt{(1+0.15*U_{10})}$

**Turbulence Intensity**

Turbulence intensity is the standard deviation of wind speed normalized by the mean wind speed over 1 hour. Turbulence intensity can be approximated by:

$$I(z)=\sigma(z)/U_z$$

$$= 0.06*[1+0.043*U_{10}]*(z/10)^{-0.22}$$
Wind Spectrum

\[
S(f) = \frac{320 \times \left(\frac{U_{10}}{10}\right)^2 \times \left(\frac{z}{10}\right)^{0.45}}{-0.468^{3.561} \left(1 + f^2\right)}
\]

where:

\( S(f) = \) spectral energy density at frequency \( f \) \([\text{m}^2/\text{Hz}]\)

\( f = \) frequency (Hz)

\[
\frac{172 \times f \times \left(\frac{z}{10}\right)^{0.3}}{f = \left(\frac{U_{10}}{10}\right)^{3/4}}
\]

In some places in AQWA non-dimensional values are output. The non-dimensional NPD spectrum is calculated as

\[ s'(f) = S(f) \times f / \sigma(10)^2 \]

where \( \sigma(10) = I(10) \times U_{10} \) is the standard deviation at \( z=10 \text{m} \).

**2.7.10.4. ISO Standard Spectrum**

This spectrum is based on the ISO spectrum as defined in ISO 19901-1:2005(E). It is the same as the NPD spectrum except that the frequency range is limited to \( 0.00167 \text{ Hz} \leq f \leq 0.5 \text{ Hz} \).

**2.7.10.5. User Defined Spectrum**

The user-defined wind spectral energy density \( S(F) \) at a frequency \( F \) (Hertz) is defined as:

\[ S(F) = S(f) \times s(z)^2 / F \]

where the non-dimensional frequency \( f \), is defined as:

\[ f = cf \times F \times z / U_z \]

and:

\( S(F) - \) Wind speed energy density

\( S(f) - \) Non-dimensional wind spectrum

\( s(z) - \) Wind speed standard deviation

\( F - \) Frequency in hertz

\( z - \) Elevation
Uz - Wind speed at elevation z

cf - Frequency coefficient

Note that the frequency coefficient, cf, is associated with the length scale in some formulations. It is not used in others; in other words, cf is unity.

A single user-defined wind spectrum U(f), is input by the user in non-dimensional form. The frequencies at which the spectral ordinates are specified are non-dimensional. The user-defined spectral energy density is therefore fully defined by the following user input parameters:

Uz - the mean wind speed (default = 0.0)
z - the reference elevation (NO DEFAULT)
cf - Frequency coefficient (default=1.0)
cs - Spectrum coefficient (default=1.0)
l(z)- turbulence intensity (default=1/6th)
f,U(f)- for each frequency

where:

s(z)= l(z)*Uz S(f)= cs*U(f)

We note that, in some form of wind spectra, cs is associated with the surface drag coefficient or roughness (Ochi and Shin, Harris-DNV, Davenport etc) while other spectra (for example, API) do not use this coefficient; in other words, cs is unity.

The z reference elevation is used to calculate the non-dimensional frequency.

Note: The wind profile for a user-defined spectrum is assumed uniform; in other words, there is no modification to the wind speed with elevation.

The standard deviation s(z) is normally about 1/6th of the mean wind speed at a reference elevation of 10m, i.e. the turbulence intensity, l(z), is about 1/6th.

By definition, the integral of S(f)/F from zero to infinity is unity. This is assumed in calculating the wind spectral energy density. It is therefore UP TO THE USER TO SPECIFY A SPECTRUM COEFFICIENT depending on the formulation of the non-dimensional spectrum.

In terms of the user defined parameters, the spectral energy density is given by:

S(F) = cs * U(f) * l(z)**2 * Uz**2 /F

and

f = cf * F * z/Uz

The following examples choose all values to be at the reference elevation 10m, for simplicity with a mean wind speed of 30.9m.
Example 1 - Specifying the API Spectrum as a User-defined Spectrum

To specify the API spectrum as a user defined spectrum, the user specifies:

- \( U_z = 30.9 \text{m/s} \) (Mean wind speed)
- \( z = 10.0 \text{m} \) (Reference elevation)
- \( cf = 40.0 \) (Frequency coefficient)
- \( cs = 1.0 \) (Spectrum coefficient)

\( \text{I}(z) = 0.1636 \) (Turbulence intensity = 0.15*2**0.125) and for each \( f \), \( U(f) = f/(1+1.5f)^{(5/3)} \)

where:

\[
 f = 40.0*10.0/30.9 \quad \text{F}
\]

\( = 12.945 \text{ F(herz)} \)

The standard deviation will then be calculated as:

\[
 s(z) = 0.1636*30.9
\]

\( = 5.055 \)

Example 2 - Specifying the Ochi and Shin Spectrum as a User-defined Spectrum

In order to input an Ochi & Shin spectrum as a user defined spectrum, we consider the definition of the Ochi & Shin spectrum, i.e.:

\[
 S(F) = S(f)*U_x^2/F
\]

and

\[
 f = F*Z/U_z
\]

Although \( cf \) is unity, \( S(f) \) is defined differently for the Ochi & Shin spectrum and is only defined at the standard reference height of 10m.

Noting that the integral of \( S(f)/F \) for the Ochi and Shin Spectrum is approximately 9.24 (giving \( cs = 1.0/9.24 = 0.1082 \)), we can calculate the standard deviation \( s(z) \) as:

\[
 s(z) = U_x*\sqrt{9.24}
\]

\( = 3.04*U_x \)

The turbulence intensity is therefore:

\[
 \text{I}(z) = 3.04*U_x/U_z
\]

Noting that \( C_{10} = 0.000794 + 0.00006658 * U_{10} \), and \( U_x = U_z*\sqrt{C_{10}} \)

\( U_x = 30.9*\sqrt{0.000794 + 0.00006658 * 30.9} \)

\( = 1.650 \)
This gives a turbulence intensity of:

\[ I(z) = \frac{3.04 \times 1.65}{30.9} \]

\[ = 0.1623 \]

We therefore specify:

\( U_z = 30.9 \text{ m/s (Mean wind speed)} \)

\( z = 10.0 \text{ m (Reference elevation)} \)

\( c_f = 40.0 \text{ (Frequency coefficient)} \)

\( c_s = 0.1082 \text{ (Spectrum coefficient)} \)

\( I(z) = 0.1623 \)

and for each \( f \), \( U(f) \) is:

\[ = (f=0.000 - 0.003) = 583 f^{**2}/0.003 \]

\[ = (f=0.003 - 0.100) = 420 f^{**.7}/(1+f^{**.35})^{**11.5} \]

\[ = (f=0.100 - 0.324) = 838 f/(1+f^{**.35})^{**11.5} \]

Note that, although only 1 user-defined wind spectrum is input, the frequency coefficient and turbulence intensity can be specified as different for each spectral combination (waves and wind).

Note also, for a user-defined spectrum, there is no assumed mean wind speed profile. The echo of the wind spectrum in the printout therefore shows the wind speed at the standard reference elevation of 10m to be the same as the mean wind speed input by the user.

### 2.7.10.6. Time Dependent Velocity

A time history of wind velocity can be defined directly in a table or by importing the information from an existing \(.WVT\) file. To define the data directly in the table, select **Insert > Wind > Time Dependent Velocity > Manual Input**. To read the data from a file, select **Insert > Wind > Time Dependent Velocity > Import WVT File**.

---

**Note**

After the data is imported, no record of the file used to import the data is retained.

---

For Manual Input, enter in each row of the table in the Data panel the **Time**, and the **Velocity** and **Direction** of the wind at that time. The time must be positive. The first entry should match with the start time of the analysis. The number of rows is not limited.
Additional rows can be added to the end of the table and they will be automatically re-sorted once entry is complete. Velocity data can also be copied and pasted from an appropriate external source.

The time defined in the table rows does not need to match the time steps defined in the analysis; the program will interpolate the wind speed and direction when necessary, using a cubic spline interpolation technique. When modelling periods of constant wind velocity, adequate data points must be provided to satisfy the interpolation method.

**Defining the .WVT File**

Comment lines beginning with * can be placed at any point in the file.

Before the data defining the time and wind velocities/directions, there must be a line containing only the text, "data_start".

After the data start, for each line the first column contains time (in s), the second column wind speed (in m/s) and the third column is wind direction (blowing towards) in degrees. The numbers in the .WVT file are in a free format and can be separated by spaces.

There is no limit on the length of the .WVT file.

The following is an example of data from a .WVT file:

```
data_start
0.0000 8.0000 90.0000
0.5000 7.8532 88.7310
1.0000 7.4271 86.0840
...```

**2.7.11. Cable Winch**

Two types of winch can be applied to a cable,

- a winch that can wind in or pay out as required to maintain a constant tension in the cable
- a winch that can wind in or pay out at a given rate to lengthen or shorten the line

To add a Cable Winch object, click on the Hydrodynamic Time Response system, then select **Cable Winch** from the Analysis toolbar or from the right click menu (Insert > Cable Winch). You can then configure the type of winch you want.

2.7.11.1. Winch that Maintains Constant Tension
2.7.11.2. Winch that Changes Cable Length
2.7.11.1. Winch that Maintains Constant Tension

Cable winches that maintain constant tension can only be used with Linear Elastic or Non-Linear Polynomial cables.

In the case of a constant tension winch, friction coefficients during the winding in (Fw) or paying out (Fp) process are required; hence the tension in the winch mooring line when winding-in is given by $T_w = T_s (1 - F_w)$ where $T_s$ is the winch tension specified. When paying-out, the winch tension is given by $T_p = T_s (1 + F_p)$. For example, if the tension specified is 1000 tonnes and Fw and Fp are 0.3 and 0.1 respectively, then the tensions will be 700 and 1100 tonnes respectively.

The initial tension is undefined. The default initial tension is the winding-in tension i.e. 700 tonnes in the example above. The winding-in friction coefficient should be specified as negative if the paying-out value of tension is required as the initial tension.

The tension will be varied according to whether the range (distance between the anchor and vessel attachment point) is increasing or decreasing. If the range is less than the initial length specified the line becomes slack and the tension is zero.

To set up the constant tension Cable Winch object, click on the object. In the Details panel:

- Select **Maintains Constant Tension** from the **Cable Type** dropdown list
- Select the cable to associate with the winch from the **Cable Selection** dropdown
- Enter the value of the **Winding In Friction**
- Enter the value of the **Paying Out Friction**
- Enter the desired **Winch Tension** value

2.7.11.2. Winch that Changes Cable Length

Cable Winches that change the cable length can only be used with Linear Elastic (without Pulleys). In the case when the winch changes the cable length, it can be made to start at the given speed after the start time, and pauses if the maximum tension is exceeded. The winch will stop paying out or winding in when the final length is reached. An additional length, $L_a$, can be entered to affect the initial stiffness of the cable and the maximum stiffness ($K_{max} = AE/L_a$).

The initial stiffness of the line, $K_0$ is used, which is equal to $EA/(L+L_a)$ for the line ($E$=Youngs' modulus, $A$ = cross sectional area). The stiffness of the line during the winch action will change as the length changes; i.e. the stiffness during the simulation, assuming that the length varies from $L$ to the final length, $L_f$, will be $EA/(L + L_a)$ to $EA/(L_f + L_a)$; where $EA = K_0 L$.

The speed entered is positive for paying out and negative for winding in. In mathematical terms the speed is $dL/dt$, where $L$ is the unstretched length of line and $t$ is time. For lines which have significant strain ($\varepsilon$) (this precludes steel which yields at about 0.001), the user may wish to consider the speed of the drum in terms of stretched length.

When winding in, the line wound onto the drum will have the same tension as the free line itself at any particular time. This means that in order to wind a length of unstretched line the effective speed must be increased by a factor of $(1+\varepsilon)$. This is done automatically. If the user wishes to simulate a stretched line speed for winding in, then the speed specified should be input with a speed reduction factor of $1/(1+\varepsilon)$, where $\varepsilon$ is the average strain.
When paying out, the adjustment of speed is not straightforward. The elastic energy of the line on the drum will depend on exactly how the line was wound on the drum originally. This 'energy' stored on the drum is unknown and is assumed to be zero, i.e. the line on the drum when paying out is assumed to be unstretched. The effective winch speed, (effectively with only 1 side of the line stretched) is \((1+\varepsilon/2)\). If the user wishes to simulate a stretched line speed for paying out, then the speed specified should be input with a reduction factor of \(1/(1+\varepsilon/2)\), where \(\varepsilon\) is the average strain.

To set up the changing cable length Cable Winch object, click on the object. In the Details panel:

- Select **Changes Cable Length** from the **Cable Type** dropdown list
- Select the cable to associate with the winch from the **Cable Selection** dropdown
- Enter the value of the **Start Time**
- Enter the cable's **Final Length** at which winching will stop
- Enter the value of the **Speed** of the winch
- Enter the **Max Tension** at which winching will pause
- Enter the **Additional Length** which affects the initial stiffness of the cable

**Note**

- The exact length of the line at any time will depend on the previous motions which have been encountered by the structure connected to this line. This in turn means that the length of the line has 'memory'. The implication of this is that in situations where initial or specific positions are used in AQWA, the line length cannot be determined and will be assumed to be the initial length. An example of this is the hot start. A warning message to this effect will be issued in these cases.

- The resolution of switching on and off the drum winch can only be the same as the time step. This means that the winch drum can only be switched at the beginning or the end of a time step and NOT in the middle. In order to conserve energy/momentum in the equations of motion, the length of the line can only be changed in steps of \((\text{time step})\times\text{speed of the winch}\). The tension resolution will therefore be stiffness\times\text{time step}\times\text{speed}. Large stiffnesses or drum speed should therefore be specified with appropriately small timesteps.

- If the unstretched length of the cable is less than 0.1m, it will be defaulted to 0.1m.

### 2.7.12. Cable Failure

A cable can be defined to fail when a given tension is reached and/or after a specified period of time. This behavior is governed by the selection in the failure mode drop down, after which options for selecting the cable, along with time and critical tensions at each end of the cable can be entered. Note that the tension in a cable will be the same at the start or the end of the cable unless Non-Linear Catenary cables are used.

To add a Cable Failure object, click on the Hydrodynamic Time Response system, then select **Cable Failure** from the Analysis toolbar or from the right click menu (**Insert > Cable Failure**).
To set up the Cable Failure object, click on the object. In the Details panel, select the cable that you want to fail from the dropdown list **Failing Cable**. Select one of the following for **Failure Mode**, and enter the parameters for that failure mode:

- **At given time** – enter the analysis **Failure Time** at which the cable fails.

- **After given time if tension at Cable Start is exceeded** – enter the analysis **Failure Time** after which the cable fails if the cable start tension exceeds **Failure Tension at Cable Start**.

- **After given time if tension at Cable End is exceeded** – enter the analysis **Failure Time** after which the cable fails if the cable end tension exceeds **Failure Tension at Cable End**.

- **After given time if tension at Cable Start or End is exceeded** – enter the analysis **Failure Time** after which the cable fails if the cable start tension exceeds **Failure Tension at Cable Start** or the cable end tension exceeds **Failure Tension at Cable End**.

- **If tension at Cable Start is exceeded** – enter the **Failure Tension at Cable Start** at which the cable fails.

- **If tension at Cable End is exceeded** – enter the **Failure Tension at Cable End** at which the cable fails.

- **If tension at Cable Start or End is exceeded** – enter the **Failure Tension at Cable Start** and the **Failure Tension at Cable End** at which the cable fails.

### 2.8. Solution

Results can be added when the Solution object is selected in the tree; this can be either before or after an analysis is performed. You can add a results object using the **Insert Result** toolbar or the context (right click) menu.

When you select a Hydrodynamic Graph result object under Solution, the graph will display in the Graph tab of the upper right pane of the window, and the data for the graph will display in the pane below the graph. Various fields will appear in the Details panel, depending on the type of graph and the axes that are displayed.

If the input to an analysis is changed, then the results objects will indicate that they are out of date via the yellow lightening bolt icon; however, if previous results exist, they will still be available until the analysis is re-run. Changing the **Axes Selection** for any graph will cause that result object to require an update, which can be done from the right click menu.

The following types of results are available:

**2.8.1. Hydrostatic Results**
2.8.1. Hydrostatic Results

The Hydrostatic results tree item enables you to view the centers of buoyancy, flotation and gravity in the graphical view once a hydrostatic or hydrodynamic solve has been performed.

Detailed hydrostatic results are available by selecting the Properties tab at the bottom of the graphical view.

In the Details panel, select the Structure whose results you want to display. You can add as many Hydrostatic results objects as you like to display the results of different structures. For each result object, you can suppress or enable the display of the Center of Gravity, Center of Buoyancy, and Center of Flotation information from the Details panel. Any number of Hydrostatic results objects can be added to the Solution.

Note

For best graphical display of hydrostatic results, it is recommended that you change the View options to enable Wireframe and turn off Select Tree Related Items.
2.8.2. Hydrodynamic Graphical Results

The Hydrodynamic Graphs button on the Insert Results toolbar allows you to plot your results using either a line, surface, or contour surface plot. When you select a graphical object in the tree, the graph will be displayed in a Graph tab in the main window pane, and the data for the graph will be displayed in the window pane below the graph.

There are a number of different types of graphs that can be displayed and a number of different axes combinations that can be displayed. 2D lines and 3D surfaces can be plotted in addition to a contour surface plot. The chart type and axes will be based on the selection that you make from the right click menu when you add the object to the Solution. Once you have created a graph object, you can select it and edit its properties in the Details pane. After inserting a new graph or changing input in an existing graph, the results need to be evaluated. The update results option is available via the context (right click) menu.

Any number of objects can be added to the Solution, and up to 4 compatible line graphs can be compared within each object.

A Maximum and Minimum value for the plotted parameter will be shown in the Details panel, and will also be highlighted in the data table (minimum is blue and maximum is red). Multiple entries are highlighted in the table if they have the same value. The positions of the Minimum and Maximum points are also given in the Details panel.

The lower right corner of the graph window contains a control that allows you to zoom and pan on the chart by selecting the corners of the control to zoom and the center to pan.

Note

AQWA always produces results in global coordinate systems; traditionally, the ship is defined with its longitudinal axis in the global X direction. However, if the user is aware of the results orientation, this does not have to be respected in DesignModeler.
Approach

Figure 2.7: Line Graph
Figure 2.8: Surface Graph
2.8.2.1. Hydrodynamic Diffraction Results

The following graph types for the Hydrodynamic Diffraction Solution object are available from the Hydrodynamic Graphs menu on the Insert Results toolbar:

- **Diffraction, Froude-Krylov, Diffraction + Froude-Krylov, Linearized Tube Drag, and Total Exciting Force Including Tube Drag**
- **Response Amplitude Operators (RAOs) and RAOs with Linearized Tube Drag**
- **Radiation Damping & Added Mass**
- **Steady Drift**
- **Sum QTF and Difference QTF**
- **Splitting Forces**
- **Bending Moment and Shear Force**

### 2.8.2.1.1. Diffraction, Froude-Krylov, Diffraction + Froude-Krylov, Linearized Tube Drag, and Total Exciting Force Including Tube Drag

**Result Description:**

2D or 3D graphs to illustrate how these forces, moments, or the corresponding phase angle change with direction, frequency or both direction and frequency. Total Exciting Force Including Tube Drag is the sum of the already existing forces (FK+Diff) and the additional Linearized Tube Drag.
Plot availability:

- Line graph presentation: Phase Angle plotted against either Direction or Frequency
- Line graph presentation: Force/Moment plotted against either Direction or Frequency
- Surface graph presentation: Phase Angle plotted against Direction + Frequency
- Surface graph presentation: Force/Moment plotted against Direction + Frequency

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, Z for forces or RX, RY, RZ for moments.
- When the plot is performed against Direction, then the required frequency can be chosen using the **Frequency** input.
- When the plot is performed against Frequency, then the required direction can be chosen using the **Direction** input.

**Line Graph Output:**

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency or Direction at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.

**Surface Graph Input:**

Use the **Component** input to select which force component to plot, either X, Y, Z for forces or RX, RY, RZ for moments.

**Surface Graph Output:**

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction at which they occur (Position of Min in X, Position of Max in X and Position of Min in Y, Position of Max in Y). These values can be parameterized by selecting the adjacent check box.

2.8.2.1.2. Response Amplitude Operators (RAOs) and RAOs with Linearized Tube Drag

**Result Description:**

2D or 3D graphs to illustrate how the amplitude and phase of the structure response change with wave direction, frequency or both direction and frequency. You can view RAOs and RAOs taking into account the linearized tube drag effects, if linearized tube drag is used.

**Plot availability:**

- Line graph presentation: Phase Angle plotted against either Direction or Frequency
- Line graph presentation: Distance/Rotation plotted against either Direction or Frequency
- Surface graph presentation: Phase Angle plotted against Direction + Frequency
• Surface graph presentation: Distance/Rotation plotted against Direction + Frequency

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

• Use the **Component** input to select which degree of freedom to plot, either X, Y, Z for translation or RX, RY, RZ for rotation.

• When the plot is performed against Direction, then the required frequency can be chosen using the **Frequency** input.

• When the plot is performed against Frequency, then the required direction can be chosen using the **Direction** input.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Distance/Rotation and the first Frequency or Direction at which they occur (**Position of Min in X**, **Position of Max in X**). These values can be parameterized by selecting the adjacent check box.

**Surface Graph Input:**

Use the **Component** input to select which degree of freedom to plot, either X, Y, Z for translation or RX, RY, RZ for rotation.

**Surface Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Distance/Rotation and the Frequency and Direction at which they occur (**Position of Min in X**, **Position of Max in X** and **Position of Min in Y**, **Position of Max in Y**). These values can be parameterized by selecting the adjacent check box.

**2.8.2.1.3. Radiation Damping & Added Mass**

**Result Description:**

2D graphs to illustrate how the Radiation Damping or Added Mass varies with frequency.

**Plot availability:**

• Line graph presentation: Radiation Damping or Added Mass plotted against Frequency

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

Use the **Subtype** and **Component** inputs to select which value from the Radiation Damping or Added Mass matrix to plot, X, Y, Z for linear components or RX, RY, RZ for rotational components.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Radiation Damping and the first Frequency at which they occur (**Position of Min in X**, **Position of Max in X**). These values can be parameterized by selecting the adjacent check box.
2.8.2.1.4. Steady Drift

Result Description:

2D or 3D graphs to illustrate the mean drift forces/moments applied on the structure and how they change with direction, frequency, or both direction and frequency.

Plot availability:

- Line graph presentation: Force/Moment plotted against either Direction or Frequency
- Surface graph presentation: Force/Moment plotted against Direction + Frequency

The Frequency Scale can be modified to be Period Scale if required.

Line Graph Input:

- Use the Component input to select which force component to plot, either X, Y, or Z for forces or RX, RY, or RZ for moments.
- When the plot is performed against Direction, then the required frequency can be chosen using the Frequency input.
- When the plot is performed against frequency, then the required direction can be chosen using the Direction input.

Line Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the first Frequency or Direction at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.

Surface Graph Input:

Use the Component input to select which force component to plot, either X, Y, or Z for forces or RX, RY, or RZ for moments.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction at which they occur (Position of Min in X, Position of Max in X and Position of Min in Y, Position of Max in Y). These values can be parameterized by selecting the adjacent check box.

2.8.2.1.5. Sum QTF and Difference QTF

Result Description:

2D graphs to illustrate how the QTF results vary with a section taken through the results with a given frequency offset. For this result to be valid, the frequencies need to be equally spaced.

3D graphs to illustrate how these quadratic transfer function (QTF) matrix (which is a force or moment) results change with frequency, for a given direction.

Plot availability:

- Line graph presentation: Phase Angle plotted against Frequency
- Line graph presentation: Force/Moment plotted against Frequency
- Surface graph presentation: Phase Angle plotted against Frequency + Frequency
- Surface graph presentation: Force/Moment plotted against Frequency + Frequency

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, or Z for forces or RX, RY, or RZ for moments.
- The required **Direction** can be chosen.
- The required **Frequency** offset can be chosen.
- When Force/Moment plots are performed, the **SubType** field is shown to enable the selection of the full **Amplitude** component, or just the **Real** or **Imaginary** components.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Force/Moment and the first Frequency or Direction at which they occur (**Position of Min in X, Position of Max in X**). These values can be parameterized by selecting the adjacent check box.

**Surface Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, Z for forces or RX, RY, RZ for moments.
- The required **Direction** can be chosen.
- When Force/Moment plots are performed, the **SubType** field is shown to enable the selection of the full **Amplitude** component, or just the **Real** or **Imaginary** components.

**Surface Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Force/Moment and the Frequency and Direction at which they occur (**Position of Min in X, Position of Max in X** and **Position of Min in Y, Position of Max in Y**). These values can be parameterized by selecting the adjacent check box.

2.8.2.1.6. Splitting Forces

**Result Description:**

2D or 3D graphs to illustrate how the Splitting Forces vary with frequency, direction, or both frequency and direction.

**Plot availability:**

- Line graph presentation: Force/Moment vs. Frequency or Direction
- Line graph presentation: Phase Angle vs. Frequency or Direction
- Surface graph presentation: Force/Moment vs. Frequency + Direction
Solution

- Surface graph presentation: Phase Angle vs. Frequency + Direction

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, or Z for forces or RX, RY, or RZ for moments.

- When the plot is performed against Direction, then the required frequency can be chosen using the **Frequency** input.

- When the plot is performed against frequency, then the required direction can be chosen using the **Direction** input.

- When Force/Moment plots are performed, the **SubType** field is shown to enable the selection of the full **Amplitude** component, or just the **Real** or **Imaginary** components.

- When Force/Moment plots are performed, use **Bounding Box Min Coordinate [X Y Z]** to enter the coordinates of one corner of a bounding box and **Bounding Box Max Coordinate [X Y Z]** to enter the coordinates of the opposite corner of the box. Then enter a **Calculation Coordinate [X Y Z]** to enter the coordinates of the point about which the moments are calculated. Values entered should be separated by spaces.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Force/Moment and the first Frequency or Direction at which they occur (**Position of Min in X, Position of Max in X**). These values can be parameterized by selecting the adjacent check box.

**Surface Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, Z for Forces or RX, RY, RZ for moments.

- When Force/Moment plots are performed, the **SubType** field is shown to enable the selection of the full **Amplitude** component, or just the **Real** or **Imaginary** components.

- When Force/Moment plots are performed, use **Bounding Box Min Coordinate [X Y Z]** to enter the coordinates of one corner of a bounding box and **Bounding Box Max Coordinate [X Y Z]** to enter the coordinates of the opposite corner of the box. Then enter a **Calculation Coordinate [X Y Z]** to enter the coordinates of the point about which the moments are calculated. Values entered should be separated by spaces.

**Surface Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Force/Moment and the Frequency and Direction at which they occur (**Position of Min in X, Position of Max in X** and **Position of Min in Y, Position of Max in Y**). These values can be parameterized by selecting the adjacent check box.

**2.8.2.1.7. Bending Moment and Shear Force**

Static Bending Moments and Shear Forces can be calculated by the SF/BM (Static) result; either all pressure components or only the Z component can be chosen. For these result types, the results are always plotted along the vessel. Alternatively, response amplitude operator (RAO) based results can be
determined for each wave direction and frequency and position. Depending upon the combination of
requirements, these will be shown on both 2D and 3D graphs appropriately. When graphs are plotted
against Position, the Frequency or Direction can be explicitly selected or they can be enveloped so that
the critical result can be identified easily. When graphs are not plotted against Position, then the calcu-
lation Position can be specified, and if appropriate, the Frequency or Direction can be explicitly defined
(in this situation they cannot be enveloped).

For all Bending Moment / Shear Force results, enter a **Neutral Axis** position in the Details panel; this
is located relative to the global coordinate system.

Bending Moment and Shear Force calculations depend upon the masses being accurately defined in
the geometry section and will only be permitted if there is only a single structure in the analysis and
the positions along the vessel are defined in the X direction.

**Result Description:**

2D or 3D graphs to illustrate the shear forces/bending moments applied on the structure and how they
change with direction, frequency, position, or combinations of direction/frequency/position.

**Plot availability:**

- Line graph presentation (static): Force/Moment plotted against X position, either for All Components or
  Z Components Only
- Line graph presentation (RAO): Force/Moment plotted against either Position, Direction, or Frequency
- Line graph presentation (RAO): Phase Angle plotted against either Position, Direction, or Frequency
- Surface graph presentation (RAO): Force/Moment plotted against Direction + Frequency, Direction + Pos-
  ition, or Frequency + Position
- Surface graph presentation (RAO): Phase Angle plotted against Direction + Frequency, Direction + Position,
  or Frequency + Position

The **Frequency Scale** can be modified to be **Period Scale** if required.

**Line Graph Input:**

- Use the **Component** input to select which force component to plot, either X, Y, or Z for forces or RX, RY,
  or RZ for moments.
- When the plot is performed against Direction (RAO), then the required frequency can be chosen using
  the **Frequency** input and the **Position** can be entered.
- When the plot is performed against Frequency (RAO), then the required direction can be chosen using
  the **Direction** input, and the **Position** can be entered.
- When the plot is performed against Position (RAO), then the required direction can be chosen using the
  **Direction** input, and the required frequency can be chosen using the **Frequency** input.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Angle or Force/Moment and the first Frequency, Direction,
or Position at which they occur (**Position of Min in X**, **Position of Max in X**). These values can be
parameterized by selecting the adjacent check box.
Surface Graph Input:

Use the Component input to select which force component to plot, either X, Y, or Z for forces or RX, RY, or RZ for moments.

Surface Graph Output:

Maximum Value and Minimum Value of Angle or Force/Moment and the Frequency and Direction or Frequency and Position or Position and Direction at which they occur (Position of Min in X, Position of Max in X and Position of Min in Y, Position of Max in Y). These values can be parameterized by selecting the adjacent check box.

2.8.2.2. Hydrodynamic Time Response Results

Under the Solution object of a Hydrodynamic Time Response system, a number of graphs will be available to track the behavior of number of parameters over time. The graphs are all line graphs, and the following categories of graphs are available:

2.8.2.2.1. Structure Position
2.8.2.2.2. Structure Velocity
2.8.2.2.3. Structure Acceleration
2.8.2.2.4. Structure Forces
2.8.2.2.5. Fender Forces
2.8.2.2.6. Joint Forces
2.8.2.2.7. Cable Forces
2.8.2.2.8. Time Step Error

2.8.2.2.1. Structure Position

Result Description:

2D graphs to illustrate the following response subtypes of the Structure Position during the analysis:

• Actual Response

• Low Frequency – The low frequency subtype values are obtained by filtering the actual response with a filter which has a cut-off frequency of one third of the frequency of the 10% spectral line + l; i.e., with N spectral lines, n = 0.1N + 1, \( \omega_{\text{cutoff}} = \frac{\omega_n}{3} \)

• Wave Frequency – the wave frequency response is that which remains when the low frequency response is subtracted from the actual response

• RAO Based – The RAO based motions are those that are calculated using only the RAOs, ignoring the affects of connections (unless these are included as additional matrices in the diffraction analysis), using the applied wave

These values are calculated at the center of gravity and are available in all translational and rotational component directions.

Plot availability:

• Line graph presentation: Distance/Rotation plotted against Time

Line Graph Input:
Use the **Component** input to select which position component to plot, either X, Y, or Z for translation or RX, RY, or RZ for rotation.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Structure Position and the Time at which they occur (**Position of Min in X, Position of Max in X**). These values can be parameterized by selecting the adjacent check box.

### 2.8.2.2.2. Structure Velocity

**Result Description:**

2D graphs to illustrate the following response subtypes of the Structure Velocity during the analysis:

- **Actual Response**

- **Low Frequency** – The low frequency subtype values are obtained by filtering the actual response with a filter which has a cut-off frequency of one third of the frequency of the 10% spectral line + 1; i.e., with N spectral lines, \( n = 0.1N + 1, \omega_{\text{cutoff}} = \omega_n/3 \)

- **Wave Frequency** – the wave frequency response is that which remains when the low frequency response is subtracted from the actual response

- **RAO Based** – The RAO based motions are those that are calculated using only the RAOs, ignoring the affects of connections (unless these are included as additional matrices in the diffraction analysis), using the applied wave

These values are calculated at the center of gravity and are available in all translational and rotational component directions.

**Plot availability:**

- Line graph presentation: Velocity plotted against Time

**Line Graph Input:**

Use the **Component** input to select which Velocity component to plot, either X, Y, or Z for translational velocity or RX, RY, or RZ for rotational velocity.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Structure Velocity and the Time at which they occur (**Position of Min in X, Position of Max in X**). These values can be parameterized by selecting the adjacent check box.

### 2.8.2.2.3. Structure Acceleration

**Result Description:**

2D graphs to illustrate the following response subtypes of the Structure Acceleration during the analysis:

- **Actual Response**
• Low Frequency – The low frequency subtype values are obtained by filtering the actual response with a filter which has a cut-off frequency of one third of the frequency of the 10% spectral line + 1; i.e., with N spectral lines, \( n = 0.1N + 1 \), \( \omega_{\text{cutoff}} = \omega_n/3 \)

• Wave Frequency – the wave frequency response is that which remains when the low frequency response is subtracted from the actual response

• RAO Based – The RAO based motions are those that are calculated using only the RAOS, ignoring the affects of connections (unless these are included as additional matrices in the diffraction analysis), using the applied wave

These values are calculated at the center of gravity and are available in all translational and rotational component directions.

**Plot availability:**

• Line graph presentation: Acceleration plotted against Time

**Line Graph Input:**

Use the **Component** input to select which Acceleration component to plot, either X, Y, or Z for translational acceleration or RX, RY, or RZ for rotational acceleration.

**Line Graph Output:**

**Maximum Value** and **Minimum Value** of Structure Acceleration and the Time at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.

### 2.8.2.2.4. Structure Forces

**Result Description:**

2D graphs to illustrate the following response subtypes of the Structure Forces during the analysis:

• All
• Mooring Sum Only
• Gyroscopic Only
• Diffraction Only
• Linear Damping Only
• Morison Drag Only
• Drift Only
• Froude-Krylov Only
• Gravitation Only
• Current Drag Only
• Wave Inertia Only
• Hydrostatic Only
• Wind Only
• Slam Only
• Point Only
• Yaw Drag Only
• Slender Body Only
• Radiation Only
• Fluid Momentum Only
• Fluid Gyroscopic Only
• Externally Applied Only
• Linear Wave Drift Damping Only

The sum of forces for each individual subtype will be shown in the graph. If all of the forces are taken in combination, they will form the result available by the All subtype. In the case where the force is not included in the analysis (e.g. Drift Forces, when drift is excluded) the subtype will produce zero values.

---

**Note**

The Point Only includes forces that have constant direction relative to the structure (i.e., the global direction may change). Where the global direction is constant, these are included in the Mooring Sum Only as they are normally formed of a cable attached to the vessel.

When including drift effects, the Froude-Krylov Only excludes those calculated on diffracting panels; instead, these are included under the Diffraction Forces.

These values are calculated at the center of gravity and are available in all translational and rotational component directions.

**Plot availability:**

• Line graph presentation: Force/Moment plotted against Time

**Line Graph Input:**

Use the Component input to select which Structure Force/Moment component to plot, either X, Y, or Z for force components or RX, RY, or RZ for rotational components.

**Line Graph Output:**

Maximum Value and Minimum Value of the Structure Force and the Time at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.


2.8.2.2.5. Fender Forces

Result Description:

2D graphs to illustrate the fender forces during the analysis. You must select the **Structure** and **Connection** to that structure (connected Fender) for which you want to display the results.

Plot availability:

- Line graph presentation: Force plotted against Time

Line Graph Input:

Use the **Component** input to select which Fender Force component to plot; either X, Y, or Z force components, or one of the following: Total Force, Compression Force, Elastic Force, Damping Force, Friction Force, Horizontal Movement, or Upward (Z) Movement.

Line Graph Output:

**Maximum Value** and **Minimum Value** of the Fender Force and the Time at which they occur (*Position of Min in X, Position of Max in X*). These values can be parameterized by selecting the adjacent check box.

2.8.2.2.6. Joint Forces

Result Description:

2D graphs to illustrate the joint forces during the analysis. You must select the **Structure** and **Connection** to that structure (connected Joint) for which you want to display the results.

Plot availability:

- Line graph presentation: Force/Moment plotted against Time

Line Graph Input:

Use the **Component** input to select which Joint Force component to plot; either X, Y, or Z force components, or RX, RY, or RZ rotational components.

Line Graph Output:

**Maximum Value** and **Minimum Value** of the Joint Force and the Time at which they occur (*Position of Min in X, Position of Max in X*). These values can be parameterized by selecting the adjacent check box.

2.8.2.2.7. Cable Forces

The force components are available for each cable. For catenary cables sections, section tension is also available.

Result Description:

2D graphs to illustrate cable tension during the analysis.

- Whole Cable Forces
• Cable Section Tension

Plot availability:

• Line graph presentation: Force or Tension plotted against Time

Line Graph Input:

• For Whole Cable Forces, use the Component input to select which Cable Force component to plot; either X, Y, or Z force components, or Anchor Uplift, Tension, or Laid Length. Use the Connection field to select which cable's characteristics to plot.

• For Cable Section Tension, use the Connection field to select which catenary cable's characteristics to plot. Use the Cable Section field to select the Catenary Section for which you want to plot section tension.

Line Graph Output:

Maximum Value and Minimum Value of Cable Force/Tension and the Time at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.

2.8.2.2.8. Time Step Error

The error, expressed as a percentage is graphed for each time step. The program outputs the expected maximum error at each time step in each degree of freedom which is related to the chosen time step. These errors can always be reduced by shortening the time step.

Result Description:

2D graphs to illustrate the maximum error per step during the analysis.

Plot availability:

• Line graph presentation: Maximum Error Percentage plotted against Time

Line Graph Input:

None.

Line Graph Output:

Maximum Value and Minimum Value of Maximum Percentage of Error and the Time at which they occur (Position of Min in X, Position of Max in X). These values can be parameterized by selecting the adjacent check box.

2.8.3. Hydrodynamic Pressures and Motions Results

The Pressures and Motions results object enables the visualization and display of a number of results generated from AQWA once a hydrodynamic solve has been performed. Any number of Pressures and Motions results may be added.

You can filter the structures (Parts) that are shown in the result. The Structure filter field provides a dropdown list that allows you to select any of the structures in the Geometry, or All of the structures. If the structure that you select is part of an Interacting Structure Group, by default all structures in the
group will be included in the result. To exclude the other structures in the group, set Include Interacting Strs to No.

The Frequency and Direction options available will be those that exist for all selected structures which were last successfully analyzed (hydrodynamic solve), or those currently specified if no analysis has been undertaken. If a frequency or direction is selected and then on a subsequent analysis not analyzed, then the option will default to the first available frequency or direction.

The Incident Wave Amplitude can be modified to provide results that are factored from the unit 1m wave that is the default; extreme modification may extend results beyond the capabilities of a linear analysis, in which case inaccurate results can be produced.

The Result Type can be defined as:

- Cyclic, where an equivalent phase position of the incident wave component can be selected (or is shown in the graph as the time as a proportion of wave period if a range is chosen)
- Amplitude
- Maximum value of the selected result
- Minimum value of the selected result

When Cyclic is selected, Wave Position (Phase) can be set to 0° (or t/T = 0) or 90° (or t/T = ¼), or you can enter a specified phase position (in rotation units), or select a Range of results for animation. If a range of results is selected, then the Number of Steps can be selected. The more steps, the smoother the animation, but the longer the results take to process.

If you select a range of results for animation, after you evaluate the Pressures and Motions results (right click on the object and select Evaluate All Results), controls appear that allow you to start, pause, and stop the animation. If a particular result is required from the animated set, click on the graph to display it. Other controls on the graph allow you to change the time over which the animation occurs and create an avi animation file.
A number of results can be presented in this manner; by default the wave height and the interpolated pressure are shown. It is only possible to plot wave contours when the structure contour type is compatible. To achieve this, the result must be plotted on nodes and must be a displacement type result. The interpolated results are determined from the panel (element) pressures that are generated from AQWA.

Any combination of wave components can be enabled and disabled to enable visualization and checking of the results. To display a particular component, set its corresponding field in the Component Selection section of the Details panel to Yes:

- Include Incident Wave
- Include Diffracted Wave
- Include Radiation Wave
- Include Hydrostatic Differential
- Include Second Order Terms
The **Structure Contour Type** can be set to Interpolated Pressure, Air Gap, Resultant Displacement, or None. **Above Water Body Display** allows the visualization of the above water bodies to be set to Dimmed or Zero Pressure. **Pressure Measurement** can be set to Force/Area, or Head of Water. If set to Head of Water, you can set the **Wave Contour Type** to Wave Height or None.

It is possible to visualize the distance between the sea surface and any point on the structure using the Air Gap selection in the **Structure Contour Type** field; the results are plotted on the structure with positive numbers indicating that the structure at that position is above the sea surface. If required, the contour legend can be adjusted to represent a solid color above or below a given value. If only the second order component is shown, the Air Gap will be shown as zero.

The sea mesh size can be altered via the **Analysis Options**, **Sea Grid Size Factor** setting. The sea mesh extends throughout the structure; however, the results that are presented within dry areas are not accurate.

The **Minimum Value** and **Maximum Value** of the results are shown and can be parameterized.

### 2.8.4. Time History Motion Results

The Time History Motion results object allows you to view an animation of the motion of the parts in your project over the entire analysis period. You can insert the Time History Motion object in the tree, either before or after running the analysis. Only one Time History Motion result can be added to an analysis.

Controls below the Geometry window allow you to start and pause the animation, change the portion of the animation that plays, and create an AVI movie file.

![Time History Motion Animation](image)

**Table 2.1: Animation Controls**

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥</td>
<td>Play the animation from the current time</td>
</tr>
<tr>
<td>⏯️</td>
<td>Pause the animation</td>
</tr>
<tr>
<td>Control</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Current Time (a slider to the right of the field can be used instead)</td>
<td>Enter the time at which to start the animation for viewing or video export</td>
</tr>
<tr>
<td>Video Stops At</td>
<td>Enter the time at which to end the video export (will change Video Length accordingly)</td>
</tr>
<tr>
<td>Video Length</td>
<td>Enter the number of seconds of animation that you want to export (will change Video Stops At accordingly)</td>
</tr>
</tbody>
</table>

To export a video of all or part of an animation set the **Current Time**, and either **Video Stops At** or **Video Length**. Then click the video export icon. A dialog box will appear asking you to provide a file name and browse to the location where you want to save the file. Click **Save**.

---

**Note**

If you are running on the Windows 7 operating system, you must be using a Basic Theme for your desktop in order to export an animation. If you are using an Aero Theme, a warning dialog box will appear when you start the export and the exported video file will not be properly created.

When entering time into the animation toolbar fields, you must press the **Enter** key before leaving the field in order to set the value.

The animation must be stopped in order to export a video. If you try to export a video while the animation is playing on the screen, nothing will happen.
Chapter 3: AQWA Workbench Interface

Hydrodynamic analysis systems are available to place on the Workbench Project Schematic from the Toolbox. After configuring the connections to/from the Hydrodynamic analysis systems and/or any inputs to the systems, you will open the AQWA Editor to perform the analysis and view the results of the Hydrodynamic analysis system. This chapter discusses how to place and configure your analysis system on the Project Schematic and describes the User Interface of the AQWA Editor. The topics covered are:

• Using the AQWA Editor User Interface
• Setting AQWA options

3.1. Hydrodynamic Systems in the Project Schematic

Hydrodynamic systems can be dragged from the Analysis Systems Toolbox to the Project Schematic to create your analysis. See Create a Hydrodynamic Analysis System (p. 3) for more detailed information on creating your analysis using the Project Schematic.

Many tasks in the Schematic can be performed using Context Menu Options that display when you right click on a cell in a Hydrodynamic system in the Project Schematic.
3.2. The AQWA Editor User Interface

Hydrodynamic analysis systems open a Workbench based editor that is a graphical interface for AQWA analyses. Using this editor you can create an element based model from geometry defined in Design Modeler format, apply AQWA specific input, and view results. The layout is similar to other Workbench based applications (e.g. the Mechanical application) and comprises a number of objects in a tree based layout.

Hydrodynamic analysis systems follow the conventions used in other ANSYS Workbench products where it is appropriate for the AQWA Editor. The user interface has a number of key areas, but is tree driven. Along with the tree and its details pane are toolbars and graphical / text display windows.

The toolbar uses a number of standard Workbench icons along with a number of specialist additions.

Table 3.1: Standard Workbench Toolbars

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View Manipulation" /></td>
<td>View manipulation</td>
</tr>
<tr>
<td><img src="image" alt="Selection Control" /></td>
<td>Selection control</td>
</tr>
<tr>
<td><img src="image" alt="File Shortcuts" /></td>
<td>File shortcuts</td>
</tr>
<tr>
<td><img src="image" alt="Show/Hide Boundaries" /></td>
<td>Show/hide element boundaries</td>
</tr>
</tbody>
</table>
### Symbols

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Comment" /></td>
<td>Add a Comment to the selected tree object</td>
</tr>
<tr>
<td><img src="image" alt="Figure" /></td>
<td>Add a Figure or Image to the selected tree object</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Report Preview" /></td>
<td>Send To</td>
</tr>
</tbody>
</table>

#### Table 3.2: AQWA Editor Toolbars

<table>
<thead>
<tr>
<th>Symbols</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Highlight" /></td>
<td>Turn on/off highlighting of objects selected in the tree</td>
</tr>
<tr>
<td><img src="image" alt="Sea" /></td>
<td>Show/hide the sea and sea bed</td>
</tr>
<tr>
<td><img src="image" alt="Solver" /></td>
<td>Solver shortcuts</td>
</tr>
</tbody>
</table>

The tree and the details are where the objects that are used to define the modelling requirements are organized. Depending upon the selection in the tree, a detail pane, normally located below the tree will show the details of the selected object. Symbols are shown next to each object in the tree to indicate its state.
For a description of a particular tree object, select a link from below. If you are an existing AQWA user, then you may also find the section Information for existing AQWA users (p. 101) a useful comparison of capabilities and definition methodology.

Each object in the tree has properties that are used to control the analysis and view the results. Each object has a different function which is described in the table below. For some objects, the right mouse button can be used to insert additional objects under that object, such as masses or result views. Alternatively, the dynamic toolbar can be used to insert additional objects.

### Table 3.3: Definition of Tree Objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Define Basic Project Information</td>
</tr>
<tr>
<td>Model</td>
<td>Define Model Folder</td>
</tr>
<tr>
<td>Geometry</td>
<td>Attach Geometry and Define Basic Info</td>
</tr>
<tr>
<td>Parts (Structures)</td>
<td>Define Structure Geometry Details</td>
</tr>
<tr>
<td>Surface Bodies</td>
<td>Define Surface Geometry Details</td>
</tr>
<tr>
<td>Line Bodies</td>
<td>Define Line Geometry Details</td>
</tr>
<tr>
<td>Point Mass</td>
<td>Define Point Mass Details</td>
</tr>
<tr>
<td>Point Buoyancy</td>
<td>Define Point Buoyancy Details</td>
</tr>
<tr>
<td>Disc</td>
<td>Define Disc Element Details</td>
</tr>
<tr>
<td>Additional Stiffness</td>
<td>Define Additional Stiffness Matrix Details</td>
</tr>
<tr>
<td>Additional Damping</td>
<td>Define Additional Damping Matrix Details</td>
</tr>
<tr>
<td>Additional Added Mass</td>
<td>Define Additional Added Mass Matrix Details</td>
</tr>
<tr>
<td>Current Force Coefficients</td>
<td>Define Current Force Coefficients</td>
</tr>
<tr>
<td>Wind Force Coefficients</td>
<td>Define Wind Force Coefficients</td>
</tr>
<tr>
<td>Connections</td>
<td>Insert Cables and Catenary Data</td>
</tr>
<tr>
<td>Cable</td>
<td>Define Cable</td>
</tr>
<tr>
<td>Catenary Data</td>
<td>Insert Catenary Sections and Joints</td>
</tr>
<tr>
<td>Catenary Section</td>
<td>Define a Catenary Cable Section</td>
</tr>
<tr>
<td>Catenary Joint</td>
<td>Define a Catenary Buoy or Clump Weight</td>
</tr>
<tr>
<td>Connection Stiffness</td>
<td>Define Connection Stiffness Matrix</td>
</tr>
<tr>
<td>Mesh</td>
<td>Define and Generate a Mesh</td>
</tr>
<tr>
<td>Mesh Sizing</td>
<td>Refine an area of the Mesh</td>
</tr>
<tr>
<td>Analysis (Name of Analysis)</td>
<td>Define Analysis Type and Name</td>
</tr>
<tr>
<td>Analysis Settings</td>
<td>Define Analysis Options</td>
</tr>
<tr>
<td>Structure Selection</td>
<td>Define Structures to be Analyzed</td>
</tr>
<tr>
<td>Gravity</td>
<td>Define Gravity for the Analysis</td>
</tr>
<tr>
<td>Wave Directions</td>
<td>Define Wave Direction Ranges</td>
</tr>
<tr>
<td>Wave Frequency</td>
<td>Define Wave Frequency Ranges</td>
</tr>
<tr>
<td>Structure Force</td>
<td>Define a time history of Structure Forces</td>
</tr>
<tr>
<td>Regular Wave</td>
<td>Define a Regular Wave</td>
</tr>
<tr>
<td>Irregular Wave</td>
<td>Define an Irregular Wave</td>
</tr>
<tr>
<td>Current</td>
<td>Define Current information</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Wind</td>
<td>Define Wind information</td>
</tr>
<tr>
<td>Cable Winch</td>
<td>Define a Cable Winch</td>
</tr>
<tr>
<td>Cable Failure</td>
<td>Define a Cable Failure</td>
</tr>
<tr>
<td>Solution</td>
<td>Insert Result Display</td>
</tr>
<tr>
<td>Hydrostatic</td>
<td>Display Hydrostatic Results</td>
</tr>
<tr>
<td>Hydrodynamic Graphs</td>
<td>Display Hydrodynamic Graphs</td>
</tr>
<tr>
<td>Pressures and Motions</td>
<td>Display Hydrodynamic Pressure and Motion Results</td>
</tr>
</tbody>
</table>

There are either one or two other windows shown, depending upon the state of the analysis or tree item that is selected:

- The main window which generally shows the model (either geometry or mesh views) in the Geometry tab, Hydrodynamic results in the Graph tab, a report of your analysis in the Report Preview tab, and Hydrostatics results in the Properties tab where you can view text based results.

- The secondary window which is used for displaying messages, controlling the results, and entering data. This will appear automatically, depending upon the tree item selected. Messages are also displayed in the Messages view of the Project Schematic.

### 3.3. Setting AQWA Application Options

Once you have created your Hydrodynamics analysis system and attached a geometry, you can open the AQWA Editor and set some options.

1. Select **Edit > Options** from the AQWA Editor window.
2. Expand the **AQWA Applet** item in the tree.

3. Select the **Analysis** entry. This panel allows you to set the following **Solver** options:

   - **AQWA executable location** — location of the executable file for the AQWA solver. *You should not have to change this from the default setting.*

   - **Severity to force showing of messages** — level of error messages that will cause reporting to the Workbench Message pane.

4. Select the **Units** entry. This panel allows you to set the following **Default Units** options:

   - **Length Unit**
   - **Force Unit**
   - **Angular Unit**
   - **Mass Unit**
   - **Frequency Unit**

5. When you are finished, click **OK**. Click **Cancel** to abort your changes.

---

**Note**

Option settings within a particular language are independent of option settings in another language. If you change any options from their default settings, then start a new Workbench session in a different language, the changes you made in the original language session are not reflected in the new session. You are advised to make the same option changes in the new language session.
Chapter 4: AQWA Common Features

There are a number of features common to all of the AQWA analysis systems. The following are discussed in this chapter:

4.1. Generating Reports
4.2. Parameters
4.3. Comments, Images, and Figures

4.1. Generating Reports

You can click on the Report Preview tab in the main window pane to generate a summary of all of the objects in your Outline. Once started, the report generation process must run to completion. Avoid clicking anywhere in the Workbench window while the report is generating because it will stop the report and may cause an error.

The Details information for each object appears as tables in the report. Figures and images appear as specified in the Outline. Charts that appear in the outline are also included.

When you are viewing the Report Preview tab, several related buttons will appear in your toolbar. Use the Print button to print a copy of the report. The Publish button will save the report in one of three formats:

• .mht, a web page archive format that can be opened by Internet Explorer 5.5 or later
• .html file with graphics in a sub directory
• .html file with graphics in the same directory

Click Publish then select the format in which you want to save from the Save as type drop down list.

Use the Send To button to send the report to an email recipient (.mht file format only), Word, or PowerPoint. The document is opened in Word as any published HTML file would be. Only the images contained in the report are imported in PowerPoint; no other information is imported.

See Report Preview for more information on generating reports.

4.2. Parameters

Certain quantities in your Hydrodynamic analysis can be exposed to the Workbench environment as parameters. A parameter may be exposed by selecting the checkbox next to its Detail field, which shows a 'P' when selected. Parameters can be used in post processing to conduct optimization analysis and “what-if” scenarios. See Working with Parameters and Design Points for more information about working with parameters.
4.3. Comments, Images, and Figures

You can insert Comment objects, Image objects, and Figure objects under various parent objects in the tree to add text or graphical information that pertains specifically to those parent objects. These objects can all be deleted from their parent objects by right clicking on them and selecting **Delete**.

4.3.1. Comments

4.3.2. Images

4.3.3. Figures

4.3.1. Comments

You can insert a Comment object in the tree by clicking on the **Comment** button in the toolbar. A window pane will open below the main graphics pane displaying a text box where you can enter the comment. Any time you click on the Comment object in the tree, this comment edit pane will open. You can enter text, do some basic formatting, change the background and foreground colors, and add pictures to the comment. In the Details view, you can enter an author name in the **Name** field. Comments will appear in a generated Report under the parent object in the tree.

**Figure 4.2: Comment Edit Pane**

![Comment Edit Pane](image)
4.3.2. Images

You can insert an Image object in the tree or save the current Model view to a file by clicking on the New Figure or Image button in the toolbar.

Figure 4.3: New Figure or Image Menu

From the drop down menu, you can select:

- **Image** to insert an Image object in the tree containing a snapshot of the Model's current view in the Geometry window.

- **Image from File...** to insert an image from a file as an Image object in the tree. Browse to an existing .bmp, .jpg, or .png file to insert the image.

- **Image to File...** to save the Model's current view. Browse to the desired location, and chose the file format: .png, .bmp, .jpg, .tif, or .eps.

In the Details view, you can enter an annotation for the image in the Text field. Image objects will appear in a generated Report under the parent object in the tree.

---

**Note**

If you are running on Windows 7, you must be using a Basic Theme for your desktop in order to capture an image. If you are using an Aero Theme, a warning dialog box will appear when inserting the Image or Image to File objects, and the image will not be properly created.

---

4.3.3. Figures

The Figure object allows you to capture a graphic displayed for a particular object in the Geometry window. A Figure object can be further manipulated (rotated, for example), unlike an Image object which is a static screen shot of the current model view, or an imported static figure. You can insert a Figure object in the tree by clicking on the New Figure or Image button in the toolbar. From the drop down menu, select Figure.

Figure 4.4: New Figure or Image Menu
In the Details view, you can enter a **Name** for the Figure object. Figures will appear in a generated Report under the parent object in the tree.

Figures allow you to capture result contours, mesh previews, graphs, etc. for later display in the Report. Any object that displays 3D graphics may contain figures. View settings maintained by a figure include:

- camera settings
- result toolbar settings
- legend configuration

A figure's view settings are fully independent from the global view settings. Figures always display the data of their parent object. For example, following a geometry Update and Solve, a result and its figures display different information but reuse the existing view and graphics options.
Chapter 5: AQWA Systems

5.1. Hydrodynamic Diffraction System

There are two analysis options for a Hydrodynamic Diffraction analysis: either to calculate the Hydrostatics only (AQWA stages 1 and 2), or to calculate the full Hydrodynamic results.

5.2. Hydrodynamic Time Response System

A Hydrodynamic Time Response system must be connected to an upstream Hydrodynamic Diffraction system. The HTR system must share the Geometry, Model, and Setup cells of the HD system.

Note

When you drop the HTR system on the HD system in the Project Schematic, you are given the option of only sharing the Geometry or Geometry and Model cells with the HTR system. Do not connect the systems in either way. If all three cells are not shared, the analysis will not work.
Chapter 6: AQWA Appendix

6.1. Information for existing AQWA users

If you are familiar with the AQWA data files and help system, then you can use this section to find where an existing command is located in the AQWA Editor tree objects.

Table 6.1: Cross reference of tree objects with AQWA commands

<table>
<thead>
<tr>
<th>AQWA Manual Reference</th>
<th>AQWA Editor Tree Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0 - Deck 0 – Preliminary Deck</td>
<td>Project</td>
</tr>
<tr>
<td>4.0.0 General Description</td>
<td>Analysis</td>
</tr>
<tr>
<td>4.0.1 JOB Card</td>
<td>Project</td>
</tr>
<tr>
<td>4.0.2 TITLE Card</td>
<td>Analysis Settings</td>
</tr>
<tr>
<td>4.0.3 OPTIONS Card</td>
<td>Analysis</td>
</tr>
<tr>
<td>4.0.4 RESTART Card</td>
<td>Analysis</td>
</tr>
<tr>
<td>4.1 - Deck 1 – (COOR) – Coordinate Positions</td>
<td></td>
</tr>
<tr>
<td>4.1.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.1.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.1.2 COORDINATE Card</td>
<td>Mesh Mesh Sizing</td>
</tr>
<tr>
<td>4.1.3 COORDINATE Card with Rotation Node Generation</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.1.4 COORDINATE STRUCTURE Card</td>
<td>Parts (Structures)</td>
</tr>
<tr>
<td>4.1.5 COORDINATE OFFSET card</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.1.6 COORDINATE card with TRANSLATION</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.1.7 COORDINATE Card with Mirror Node Gen’</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.1.8 NOD5 card - 5-digit node numbers</td>
<td>Always enabled</td>
</tr>
<tr>
<td>4.2 Deck 2 (ELM*) – Element Topology</td>
<td></td>
</tr>
<tr>
<td>4.2.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.2.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.2.2 ELEMENT TOPOLOGY Card</td>
<td>Mesh, Mesh Sizing, Line Bodies, Point Mass, Point Buoyancy, Disc</td>
</tr>
<tr>
<td>4.2.3 SYMX and SYMY - X and Y Symmetry Cards</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.2.4 HYDI card - Hydrodynamic Interaction</td>
<td>Structure Selection</td>
</tr>
<tr>
<td>4.2.5 RMXS/RMYS cards - Remove Symmetry</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.2.6 MSTR Card - Move Structure</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.2.7 FIXD Card - Fix Structure</td>
<td>Parts (Structures)</td>
</tr>
<tr>
<td>4.2.8 PFIX Card - Partially Fix Structure</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.2.9 VLID Card - Suppression of Standing Waves</td>
<td>Parts (Structures), Surface Bodies</td>
</tr>
<tr>
<td>AQWA Manual Reference</td>
<td>AQWA Editor Tree Object</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>4.2.10 ASYM Axi-Symmetric Structure Generation</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.2.11 ILID Card - Suppression of Irregular Frequencies</td>
<td>Surface Bodies</td>
</tr>
<tr>
<td>4.2.12 ZLWL Card - Waterline Height</td>
<td>Geometry</td>
</tr>
<tr>
<td>4.3 Deck 3 (MATE) – Material Properties</td>
<td></td>
</tr>
<tr>
<td>4.3.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.3.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.3.2 MATERIAL PROPERTY Card</td>
<td>Line Bodies, Point Mass, Point Buoyancy, Disc</td>
</tr>
<tr>
<td>4.4 Deck 4 (GEOM) – Geometric Properties</td>
<td></td>
</tr>
<tr>
<td>4.4.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.4.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.4.2 GEOMETRIC Property and CONTINUATION Card</td>
<td>Line Bodies, Point Masses, Point Buoyancy, Disc</td>
</tr>
<tr>
<td>4.5 Deck 5 (GLOB) – Global Parameters</td>
<td></td>
</tr>
<tr>
<td>4.5.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.5.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.5.2 DPTH Card (Optional) - Water Depth</td>
<td>Geometry</td>
</tr>
<tr>
<td>4.5.3 DENS Card (Optional) - Water Density</td>
<td>Geometry</td>
</tr>
<tr>
<td>4.5.4 ACCG Card (Optional) – Gravitational Acceleration</td>
<td>Gravity</td>
</tr>
<tr>
<td>4.6 Deck 6 (FDR*) – Frequencies and Directions Table</td>
<td></td>
</tr>
<tr>
<td>4.6.0 General Description</td>
<td></td>
</tr>
<tr>
<td>4.6.1 Deck Header</td>
<td></td>
</tr>
<tr>
<td>4.6.2 FREQ/PERD/HRTZ Card - Frequencies/Periods at which the Parameters are Defined</td>
<td>Wave Frequencies</td>
</tr>
<tr>
<td>4.6.3 DIRN Card - Directions at which the Parameters are Defined</td>
<td>Wave Directions</td>
</tr>
<tr>
<td>4.6.4 MVEF Card - Move Existing Freq‘ Parameters</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.5 DELF Card - Delete Frequency Parameters</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.6 CSTR Card - Copy from Structure Number</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.7 FILE Card - Copy from File Unit</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.8 CPYF/CPYP/CPYH Cards - Copy Freq’ Param’s</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.9 CPYS Card - Copy Stiffness Matrix</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.10 CPDB Card - Copy Data Base</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.6.11 FWDS Card - Define Forward Speed</td>
<td>Wave Directions</td>
</tr>
<tr>
<td>4.7 DECK 7 (WFS*) – Wave Frequency Dependent Parameters and Stiffness Matrix</td>
<td>Parts (Structures), Additional Stiffness, Additional Damping, Additional Added Mass, Connection Stiffness</td>
</tr>
<tr>
<td>4.8 DECK 8 (DRC*) – Drift Force Coefficients</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.9 DECK 9 (DRM*) – Drift Motion Parameters</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.10 DECK 10 (HLD*) – Hull Drag Coefficients and Thruster Forces</td>
<td>Current Force Coefficients, Wind Force Coefficients</td>
</tr>
<tr>
<td>AQWA Manual Reference</td>
<td>AQWA Editor Tree Object</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>4.11 DECK 11 (ENVR) – Environmental Parameters</td>
<td>Wind (non spectral definition), Current</td>
</tr>
<tr>
<td>4.12 DECK 12 (CONS) – Constraints</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.13 Deck 13 (SPEC) – Spectral Parameters</td>
<td>Irregular Wave, Wind (spectral definition)</td>
</tr>
<tr>
<td>4.13N Deck 13 (WAVE) – Regular Wave Parameters</td>
<td>Regular Wave</td>
</tr>
<tr>
<td>4.14 Deck 14 (MOOR) – Mooring Lines Description</td>
<td>Cables, Cable Winch, Cable Failure, Analysis Settings</td>
</tr>
<tr>
<td>4.15 Deck 15 (STRT) – Starting Conditions</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.15N Deck 15 (STRT) – Starting Conditions (NAUT)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.15D Deck 15 (STRT) – Starting Conditions (DRIFT)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.16 Deck 16 (STRT) – Starting Conditions</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.16L Deck 16 (STRT) – Starting Conditions (LINE)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.16B Deck 16 (STRT) – Starting Conditions (LIBRIUM)</td>
<td>Analysis Settings</td>
</tr>
<tr>
<td>4.17 Deck 17 (HYDC) – Hydrodynamic parameters for non diffracting elements</td>
<td>Analysis Settings, Parts (Structures)</td>
</tr>
<tr>
<td>4.18 Deck 18 (PROP) – Printing Options</td>
<td>Not Supported</td>
</tr>
<tr>
<td>4.21 Deck 21 (ENLD) – Element and Nodal Loads</td>
<td>Not Supported</td>
</tr>
<tr>
<td>All AQWA-WAVE commands</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>

6.2. Transferring Pressures and Motions (Frequency Domain) to Mechanical Models

Pressures and motion effects of a rigid body modelled during the Hydrodynamic Diffraction Analysis can be applied to ANSYS Mechanical APDL for further analysis. Static or Transient analyses are performed in ANSYS Mechanical APDL using a specified phase angle to obtain the results from the frequency domain based hydrodynamic diffraction analysis. For further details see Applying Ocean Loading from a Hydrodynamic Analysis in the Mechanical APDL Advanced Analysis Guide which details the methodology used in Mechanical APDL to achieve this.

**Note**

It is not possible to transfer pressure and motions from a hydrodynamic time response analysis to ANSYS Mechanical APDL.

The ocean wave loading requires the results from the hydrodynamic diffraction analysis to be generated in a text file format. This can be achieved by running the AQWA2NEUT program after the hydrodynamic diffraction analysis.

To run AQWA2NEUT, use a command of the form (assuming that the executable is on path and the AQWA database files are in the running directory):

```
AQWA2NEUT p1 p2
```

where

p1 AQWA database name without extension
Appendix

p2 AQWA structure number (optional, defaults to 1)

A file called $p1\_p2.ahd$ will be generated. This file can be opened in a text editor if required.
Index

A
aqwa
  attach geometry, 4
  create analysis system, 3
attaching geometry, 4

G
gometry
  attach - aqwa, 4